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1. Introduction 
The purpose of this XML Specification is to provide information on how to use Extensible 
Markup Language (XML) files in the Group Practice Reporting Option (GPRO) Web Interface. 
The data stored in the database may be exported, or the data may be updated using XML files. 

The Web Interface accepts data from ACO GPROs and PQRS GPROs. Where the information 
applies to both the ACO GPROs and the PQRS GPROs, the two GPRO types will be referred to 
as “group”. If the information only applies to one of the GPRO types, the type of GPRO will be 
specified in the document. 

The XML files exported from the Web Interface may be imported into Excel spreadsheet. The 
data in the Excel spreadsheets may then be updated before exporting the Excel spreadsheet to 
the XML format required for upload into the Web Interface. 

For organizations using custom coding, this document provides the valid format that must be 
used to create the XML files to be uploaded into the Web Interface. 

This PDF is provided as a reference only. It is NOT 508 compliant. For a 508 compliant version 
of this content, please refer to the Online Content. 

2. XML Schema Definitions (XSD) 
Depending on your browser version (IE8 vs. IE9), you may need to perform additional steps to 
download the XSD files as text files.  

2.1. Download & Save XSD Files 
1. From the XSD files listed below, place your mouse over the desired file, right click, and 

select Save Target As....  
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2. The Save As window appears. Specify a location to save the XSD File and click Save.  

 

2.2. XSD Files 
Click here for the Patient XSD. For more information, see Patients XML. 

Click here for the Patient Discharge XSD. For more information, see Patient Discharge XML. 

Click here for the Patient Ranking XSD. For more information, see Patient Ranking XML. 
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Click here for the Clinic XSD. For more information, see Clinics XML. 

Click here for the Providers XSD. For more information, see Providers XML. 

3. Release Notes 
The list below details the revisions made since the release of the 2012 ACO GPRO XML 
Specifications and the 2012 PQRS GPRO XML Specifications. The 2013 GPRO XML 
Specifications have been updated to reflect the 2013 measures and the 2013 Web Interface. 
The measures for the 2013 GPRO Web Interface and the 2013 ACO Web Interface are aligned, 
and the XML specifications have been combined into a single document. 

3.1. Changes for ACO GPRO Only 

3.1.1. Measures 
• PREV-12 removed No – System Reasons for Clinical Depression Screening as a valid 

answer. 

3.2. Changes for PQRS GPRO Only 

3.2.1. Measures 
• COPD and all associated measure tags removed. 

• CAD-1: Antiplatelet Therapy tags removed 

• DM-7: Eye Exam tags removed. 

• DM-8: Foot Exam tags removed. 

• HF-1: LVEF Assessment Results tags removed. 

• HF-2: LVF Testing tags removed. 

• HF-5: Patient Education tags removed. 

• HF-7: ACE-I/ARB Therapy for Patients with LVSD. 

• PREV-12 tags added 
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3.3. Changes for ACO GPRO and PQRS GPRO 

3.3.1. Medical Record Found 
• The order of the XML tags has been modified for the changes in the Medical Record 

Found and skip reasons. See Appendix A – XML Elements for Patients XML File and 
Appendix B – XML Elements for Patient Discharge XML File for required order of XML 
tags. 

• A value for Medical Record Found is required for all patients. 

• A value for Medical Record Found is only required once for a patient. 

• If Medical Record Found is Yes, confirmation that the patient is qualified for the patient 
care measures in which they are ranked must be provided. 

3.3.2. Skipping a Patient 
• HMO Enrollment was added as a reason a patient may be marked as Not Qualified for 

Sample. 

• When the patient is not qualified for the sample with a reason of In Hospice, Deceased, 
Moved out of Country, or HMO Enrollment, the values for Medical Record Found, 
Reason, and Date only need to be provided once. The system will mark the patient as 
skipped in all modules or patient care measures in which the patient is ranked. 

• Other CMS Approved Reason for skipping a patient is included in the disease 
confirmation for CAD, DM, HF, HTN, or IVD. The patient will only be marked as skipped 
in the disease module where the Other CMS Approved Reason value is used. 

• Other CMS Approved Reason for skipping a patient is included in the measure 
confirmation for each CARE and PREV measure. Patients may be skipped in a single 
Care or PREV measure. 

3.3.3. Demographics 
• Up to three provider NPIs may be used for a patient. 

• The Clinic ID was changed from a system generated ID to a pre-populated or user 
added identifier. The Clinic ID was added to the Clinic XML file. 

• The Abstraction Date is no longer used. 

• First name, last name, DOB, and gender cannot be updated using XML, must be done 
on the Web Interface. 
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3.3.4. Measures 
• All dates of service must be in the 2013 calendar year. 

• DM-12 Tobacco Non Use component changed from Tobacco Use to Tobacco Non Use. 
Therefore, the meaning of the answers has been changed to: 

 Yes (Patient was screened and identified as not using tobacco (non-user)) 

 No (Patient was screened and identified as a tobacco use) 

 Not Screened (Patient was not screened for tobacco use) 

• PREV-9 removed No – System Reasons for Calculated BMI as a valid answer. 

• PREV-10 added No – Medical Reasons for Tobacco Use as a valid answer. 

3.3.5. Error Codes 
• Error codes were simplified and where possible the XML tag associated with the error is 

included in the error message. 

3.3.6. XML Tag order and Valid Values 
• The required order of the XML tags in the Patients XML file have been combined into 

one table in Appendix A 

• The required order of the XML tags in the Patient Discharge XML file have been 
combined into one table in Appendix B 

3.3.7. Patient Discharge XML File 
• Modified the file format to allow the Patient Discharge XML file to be generated from an 

Excel file. 

• The Medicare ID may be used more than once if the patient has multiple discharges. 

The next two tables provide the changes to the Patients and Patient Discharge XML Tags  

Patients XML Tag 

2013 Tag 2012 Tag Comment 

<web-interface> <aco-gpro> New indicator of submission type 
opening tag - ACO GPRO Only 



Release Notes 

GPRO-ACO XML Specification v2.0 6 PQRS PY2013 12/20/2013 

Patients XML Tag 

2013 Tag 2012 Tag Comment 

<web-interface> <pqrs-gpro> New indicator of submission type 
opening tag – PQRS GPRO Only 

<group-tin> <aco-tin> New indicator for the ACO GPRO 
Primary TIN – ACO GPRO Only 

<group-tin> <gpro-tin> New indicator of the PQRS GPRO TIN – 
PQRS GPRO Only 

<provider-npi-two> N/A Allows a second provider to be 
associated to a patient 

<provider-npi-three> N/A Allows a third provider to be associated 
to a patient 

<clinic-identifier> <clinic-id> Changed from the system generated ID 
to a pre-filled or user specified identifier 

N/A <abstraction-date> Tag not used in 2013 

<medical-record-found> <care-medical-record-
found> 

<prev-medical-record-
found> 

Patient level tag used once to indicate 
medical record found.  A value is 
required for all patients. 

<medical-not-qualified-
reason> 

<care-not-qualified-reason> 

<cad-not-qualified-reason> 

<dm-not-qualified-reason> 

<hf-not-qualified-reason> 

<htn-not-qualified-reason> 

<ivd-not-qualified-reason> 

<prev-not-qualified-reason> 

Patient level tag used once to skip the 
patient in modules/patient care 
measures in which the patient is ranked 
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Patients XML Tag 

2013 Tag 2012 Tag Comment 

<medical-not-qualified-
date> 

<care-not-qualified-date> 

<cad-not-qualified-date> 

<dm-not-qualified-date> 

<hf-not-qualified-date> 

<htn-not-qualified-date> 

<ivd-not-qualified-date> 

<prev-not-qualified-date> 

Patient level tag used once to skip the 
patient in modules/patient care 
measures in which the patient is ranked 

<caremedcon-confirmed> N/A Used to confirm or skip a patient in the 
CARE-1 measure only 

<carefalls-confirmed> N/A Used to confirm or skip a patient in the 
CARE-2 measure only 

<pcmammogram-
confirmed> 

N/A Used to confirm or skip a patient in the 
PREV-5 measure only 

<pccolorectal-confirmed> N/A Used to confirm or skip a patient in the 
PREV-6 measure only 

<pcflushot-confirmed> N/A Used to confirm or skip a patient in the 
PREV-7 measure only 

<pcpneumoshot-
confirmed> 

N/A Used to confirm or skip a patient in the 
PREV-8 measure only 

<pcbmiscreen-
confirmed> 

N/A Used to confirm or skip a patient in the 
PREV-9 measure only 

<pctobaccouse-
confirmed> 

N/A Used to confirm or skip a patient in the 
PREV-10 measure only 

<pcbloodpressure-
confirmed> 

N/A Used to confirm or skip a patient in the 
PREV-11 measure only 
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Patients XML Tag 

2013 Tag 2012 Tag Comment 

<pcdepression-
confirmed> 

N/A Used to confirm or skip a patient in the 
PREV-21 measure only 

</web-interface> </aco-gpro> New indicator of submission type closing 
tag - ACO GPRO Only 

</web-interface> </pqrs-gpro> New indicator of submission type closing 
tag – PQRS GPRO Only 

  

Patient Discharge XML Tag 

2013 Tag 2012 Tag Comment 

<web-interface> <aco-gpro> New indicator of submission type 
opening tag - ACO GPRO Only 

<web-interface> <pqrs-gpro> New indicator of submission type 
opening tag – PQRS GPRO Only 

<group-tin> <aco-tin> New indicator for the ACO GPRO 
Primary TIN – ACO GPRO Only 

<group-tin> <gpro-tin> New indicator of the PQRS GPRO TIN – 
PQRS GPRO Only 

<medical-record-found> <care-medical-record-
found> 

Patient level tag used once to indicate 
medical record found.  A value is 
required for all patients. 

<medical-not-qualified-
reason> 

<care-not-qualified-reason> Patient level tag used once to skip the 
patient in modules/patient care 
measures in which the patient is ranked 

<medical-not-qualified-
date> 

<care-not-qualified-date> Patient level tag used once to skip the 
patient in modules/patient care 
measures in which the patient is ranked 
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Patient Discharge XML Tag 

2013 Tag 2012 Tag Comment 

<caremedcon-confirmed> N/A Used to confirm or skip a patient in the 
CARE-1 measure only 

N/A <discharge> Tag deleted - Changed from one patient 
tag/multiple discharge records to one 
patient tag/one discharge record, Patient 
tag and Medicare ID tag are repeated for 
each discharge record. 

</web-interface> </aco-gpro> New indicator of submission type closing 
tag - ACO GPRO Only 

</web-interface> </pqrs-gpro> New indicator of submission type closing 
tag – PQRS GPRO Only 

4. XML Specifications 

4.1. XML Specifications 
The measurement period for the 2013 Program Year is from 01/01/2013 through 12/31/2013, 
unless otherwise indicated for a specific measure. 

The Web Interface allows exporting data for five types of files: 

1. Patients 

2. Patient Discharge 

3. Patient Ranking 

4. Clinics 

5. Providers 

The Patients XML and Patient Discharge XML files may also be uploaded to update the 
patient’s data. Patients XML files and Patient Discharge XML file that are to be uploaded into 
the Web Interface contain Byte Order Mark (BOM) so it is imperative that an editor that allows 
saving the file without BOM is used. 

Dates specified throughout the document are in the format of MM/DD/YYYY. Months and dates 
containing a single digit may be entered with or without a leading zero (0). For example, July 4, 
2013 may be entered as 07/04/2013 or as 7/4/2013. 
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The five disease modules, Coronary Artery Disease (CAD), Diabetes Mellitus (DM), Heart 
Failure (HF), Hypertension (HTN), and Ischemic Vascular Disease (IVD) are collectively referred 
to as disease modules. The two individually sampled Care Coordination/Patient Safety 
measures (CARE-1 and CARE-2) are collectively referred to as CARE measures. The eight 
individually sampled Preventive Care measures (PREV-5, PREV-6, PREV-7, PREV-8, PREV-9, 
PREV-10, PREV-11, and PREV-12) are collectively referred to as PREV measures. The CARE 
measures and the PREV measures are referred to as Patient Care Measures. 

4.2. File Processing 

4.2.1. File Processing 
In this topic, learn about the following: 

Patient Status 

Disease Module or CARE or PREV Measure Rank 

XML Element Processing 

XML Element Order 

4.2.2. Patient Status 

4.2.2.1. Patient Status 

The patient’s status in a disease module or patient care measure is set by the system and will 
have one of four values: 

• Complete 

• Incomplete 

• Skipped 

• Not Ranked 

The system will set the status for the patient based on the data that has been entered and 
saved in the Web Interface or a successful XML upload. The XML uploads for the Patients XML 
and the Patient Discharge XML can cause the system to change the status to Complete, 
Incomplete, or Skipped based on the uploaded values. The Not Ranked status is set at the 
time the data is loaded and cannot be changed. 

4.2.2.2. Marking a Patient as Complete 

The Medical Record Found value must be provided for all patients. The system will mark a 
patient as Complete when the Medical Record Found value is Yes, and the other required 
information is provided. 
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For the CAD (see Coronary Artery Disease), DM (see Diabetes Mellitus), HF (see Heart 
Failure), HTN (see Hypertension), and IVD (see Ischemic Vascular Disease) disease modules, 
in addition to the Medical Record Found value, the other required information needed for the 
system to mark a patient as Complete in a module includes confirmation of the diagnosis and 
all required quality measure components. The information on the disease confirmation and 
required quality measure components is detailed in the referenced sections. 

For the CARE measures (see CARE-1 and CARE-2) and the PREV measures (see Preventive 
Care), in addition to the Medical Record Found value, the other required information needed 
for the system to mark a patient as Complete in the measure includes confirmation that the 
patient is qualified for the measure and all required measure components. The information on 
the measure confirmation and required measure components is detailed in the referenced 
sections. 

The required measure components for the disease modules, individually sampled CARE 
measures, or PREV measures are detailed in the sections for the measures below. 

4.2.2.3. Marking a Patient as Incomplete 

The system will mark a patient as Incomplete in a disease module, CARE measure, or PREV 
measure for one of the following reasons: 

• The default status for a patient ranked in a disease module, CARE measure, or 
individually sampled PREV measure is Incomplete 

• Patient is ranked in a disease module, CARE measure, or PREV measure and a value 
has not been provided for Medical Record Found 

• Patient is ranked in a disease module, CARE measure, or PREV measure, Medical 
Record Found is set to Yes, but required confirmation and/or quality measure 
components do not have a value 

4.2.2.4. Marking a Patient as Skipped 

The Medical Record Found value must be provided for all patients. The system will mark a 
patient as Skipped when the Medical Record Found value is set to one of the valid skip 
reasons, and the other required information is provided. 

A patient may be skipped in all disease modules, CARE measures, or PREV measures in which 
they are ranked for the following reasons: 

• Patient medical record is not found 

• Patient is deceased 

• Patient is in hospice 

• Patient moved out of the country 

• Patient was enrolled in a Health Maintenance Organization (HMO) during the 
measurement period 
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After setting the Medical Record Found to Yes, a patient may be skipped in one disease 
module, CARE measure, or PREV measure in which they are ranked for the following reasons: 

• Patient diagnosis not confirmed by patient records 

• Not qualified for medical reasons (Diabetes disease module only) 

• Other CMS approved reason (Allowed on a case by case basis) 

If the medical record was not found, the patient will be skipped in all disease modules, CARE 
measures, or individually sampled PREV measures in which they are ranked. When setting the 
value for Medical Record Found to Medical Record Not Found, no other values are required 
for the system to set the patient to Skipped. 

• If the medical record was found, but the patient is not qualified for the sample because 
they are deceased, in hospice, moved out of the country, or enrolled in an HMO the 
patient will be skipped in all disease modules, or patient care measures in which they 
are ranked. When setting the value for Medical Record Found to Not Qualified for 
Sample, the reason the patient is not qualified for the sample and the date they became 
ineligible are required for the system to set the patient to Skipped. 

• If the medical record was found, but the diagnosis is not confirmed by the patient 
records, the patient is not qualified for the DM module for medical reasons, or the patient 
is not qualified for other CMS approved reasons, the system will set the patient to 
Skipped only in the disease modules, or patient care measures where the skip reason is 
set. The Medical Record Found must be set to Yes, and the skip reason must be set in 
the confirmation of the disease module, CARE measure, or PREV measure. 

If the group must skip one or more patients in a disease module, individually sampled CARE 
measure, or PREV measure, then they are required to complete the data for an equal number of 
additional, consecutively ranked patients within the disease module, CARE measure, or PREV 
measure. A Large PQRS GPRO or an ACO GPRO must report on 411 consecutively confirmed 
and completed patients, unless the sample of patients is exhausted. A Medium PQRS GPRO 
must report on 218 consecutively confirmed and completed patients, unless the sample of 
patients is exhausted 

4.2.2.5. Marking a Patient as Not Ranked 

The system will mark a patient as Not Ranked when they are not selected for the disease 
module or CARE measure, or PREV measure. The Not Ranked status is set during the initial 
data load and cannot be changed during the submission period. 

4.2.3. Disease Module or Patient Care Measure Rank 
The patient’s rank in a disease module, CARE measure, or PREV measure provides the 
patient’s assigned order in the module or patient care measure and is provided in the exported 
files for information only. The rank cannot be changed from the value assigned to the patient 
during the patient sampling. If the patient has not been selected for the disease module, CARE 
measure, or PREV measure, the associated rank will not be included in the XML files exported 
from the Web Interface. 
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The rank is included in the exported Patient XML file to assist in determining which patients are 
necessary to complete in order to meet the 411 consecutively confirmed and completed patients 
for a Large PQRS GPRO or ACO GPRO, or the 218 consecutively confirmed and completed 
patients for a Medium PQRS GPRO. 

The patient’s rank is not required in the XML files to be uploaded. If the rank is included in the 
file, the XML element and associated data will be ignored. 

The tags for all the disease modules or patient care measures are listed in the following table. 
When used in an XML file, the tags for the disease module, CARE measure, or PREV measure 
must be used in the order specified in Appendix A – XML Elements for Patients XML File. 

The table below shows the available values and XML format for the Disease Module or CARE 
or PREV Measure Ranks. 

Available Values Sample XML Tag Other Parameters 

1 – 616 <caremedcon-
rank>12<caremedcon-rank> 

Ignored on Upload, provided for 
information on Export 

1 - 616 <carefalls-rank>68</carefalls-
rank> 

Ignored on Upload, provided for 
information on Export 

1 - 616 <cad-rank>221</cad-rank> Ignored on Upload, provided for 
information on Export 

1 – 616 <dm-rank>221</dm-rank> Ignored on Upload, provided for 
information on Export 

1 – 616 <hf-rank>221</hf-rank> Ignored on Upload, provided for 
information on Export 

1 – 616 <htn-rank>221</htn-rank> Ignored on Upload, provided for 
information on Export 

1 – 616 <ivd-rank>15</ivd-rank> Ignored on Upload, provided for 
information on Export 

1 - 616 <pcmammogram-
rank>499</pcmammogram-
rank> 

Ignored on Upload, provided for 
information on Export 

1 - 616 <pccolorectal-
rank>6</pccolorectal-rank> 

Ignored on Upload, provided for 
information on Export 
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Available Values Sample XML Tag Other Parameters 

1 - 616 <pcflushot-rank>482</pcflushot-
rank> 

Ignored on Upload, provided for 
information on Export 

1 - 616 <pcpneumoshot-
rank>12</pcpneumoshot-rank> 

Ignored on Upload, provided for 
information on Export 

1 - 616 <pcbmiscreen-
rank>99</pcbmiscreen-rank> 

Ignored on Upload, provided for 
information on Export 

1 - 616 <pctobaccouse-
rank>110</pctobaccouse-rank> 

Ignored on Upload, provided for 
information on Export 

1 - 616 <pcbloodpressure-
rank>616</pcbloodpressure-
rank> 

Ignored on Upload, provided for 
information on Export 

1 - 616 <pcdepression-
rank>616</pcdepression-rank> 

Ignored on Upload, provided for 
information on Export 

4.2.4. XML Element Processing 
Only the XML elements for the disease modules or patient care measures in which the patient is 
ranked should be used. Using an element for a disease module, CARE measure, or PREV 
measure in which the patient is not ranked will not generate a format validation error, but the 
data in the XML file for that element will not be stored in the database. 

Any value uploaded in the XML file will overwrite existing values in the database. 

• If an XML element is included in the file, but the element is an empty tag, the tag will not 
be processed, and data associated with the tag will not be updated in the database. 

• If the value in the XML tag is a minus one (-1), the data associated with the tag will be 
changed to a null value in the database. This is useful if, for example, an incorrect value 
has been uploaded and the user wants to remove it from the database. 

Inclusion of XML elements for fields that do not require a tag is optional. All required data must 
be provided for satisfactory reporting, but the data does not need to be provided in a single XML 
file. This allows for flexibility when creating the XML files. Examples of options include: 

• Uploading data using one XML file per disease module, CARE measure, or PREV 
measure. 

• Uploading data using one XML file per measure component, such as the blood pressure 
date taken. 
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• Uploading only data available in the electronic health record system in an XML file. 

4.2.5. XML Element Order 
If an optional XML element is included in the file, the elements must be listed in the specified 
order. 

Appendix A – XML Elements for Patients XML File, lists all possible XML elements, along with 
the allowable values for each element, in the Patient file in the required order. 

Appendix B – XML Elements for Patient Discharge XML File, lists all possible XML elements, 
along with the allowable values for each element, in the Patient Discharge file in the required 
order 

4.3. Patients XML 

4.3.1. Patients XML 
The Patients XML can be used to export all currently stored data for the patients or to update 
the patient data by uploading an XML file. The Patients XML contains the patient’s demographic 
information and all disease module, CARE measure, or PREV measure data, with the exception 
of the CARE-1 Medication Reconciliation quality measure data. 

When exporting the data for the Patients XML, the Web Interface allows the selection of one or 
more disease modules or patient care measures on the Export Data page. If a patient is ranked 
in a disease module, CARE measure, or PREV measure, but data has not been stored in the 
database for the associated XML elements, the elements will be included, but the element will 
be an empty tag. 

In total, there are 15 modules/patient care measures which have XML data: five disease 
modules, two Care Coordination/Patient Safety measures, and eight Preventive Care measures: 

• Medication Reconciliation (CARE-1) 

• Falls: Screening for Future Fall Risk (CARE-2) 

• Coronary Artery Disease (CAD) 

• Diabetes Mellitus (DM) 

• Heart Failure (HF) 

• Hypertension (HTN) 

• Ischemic Vascular Disease (IVD) 

• Preventive Care and Screening: Breast Cancer Screening (PREV-5) 

• Preventive Care and Screening: Colorectal Cancer Screening (PREV-6) 
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• Preventive Care and Screening: Influenza Immunization (PREV-7) 

• Preventive Care and Screening: Pneumococcal Vaccination for Patients 65 Years and 
Older (PREV-8) 

• Preventive Care and Screening: Body Mass Index (BMI) Screening and Follow-Up 
(PREV-9) 

• Preventive Care and Screening: Tobacco Use: Screening and Cessation Intervention 
(PREV-10) 

• Preventive Care and Screening: Screening for High Blood Pressure and Follow-Up 
Documented (PREV-11) 

• Preventive Care and Screening: Screening for Clinical Depression and Follow-Up Plan 
(PREV-12) 

The XML file generated by the Web Interface will only include the patients ranked in the 
selected module or measure. An option is provided to allow the patient data to be exported in 
one of two ways. 

1. Export only selected module or patient care measure data for the patient. If a patient is 
ranked in multiple modules or patient care measures, only the XML data elements 
associated with the selected modules or patient care measures will be included for that 
patient. If a patient is ranked in a module or measure that has been selected and is also 
ranked in a module or patient care measure that has not been selected, the data for the 
unselected module or patient care measure will not be included in the file. This option 
prevents duplicate data for a patient when data is exported one module or patient care 
measure at a time. 

2. Export all module or measure data for the patient. If a patient is ranked in multiple 
modules or patient care measures, all XML data elements for any module or patient care 
measure in which the patient is ranked will be included for the patient. If a patient is 
ranked in a module or patient care measure that has been selected and is also ranked in 
a module or patient care measure that has not been selected, the data for the 
unselected modules or patient care measures will also be included in the file. This option 
allows exporting all data for all modules or patient care measures for a patient when data 
is exported one module or patient care measure at a time. 

Note that selecting the CARE-1 measure when exporting the Patients XML file will only export 
the patient demographics and rank in the measure. To export the discharge dates and 
associated confirmation for office visits and medication reconciliation, the Patient Discharge 
XML file must be exported. 

4.3.2. XML Declaration and Submission Header 
The XML Declaration must meet the following three requirements or the file will be rejected as 
an invalid file: 

1. The XML Declaration must be on the first line 

2. The XML Declaration may not contain any other XML elements 
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3. The XML Declaration must be an exact match for the valid value specified in Appendix A 
– XML Elements for Patients XML File 

A submission header is required at the beginning of each Patients XML file. The opening tag for 
the submission header must be the first XML element in the file, and the closing tag for the 
submission header must be the last XML element in the file. The submission opening element 
<submission> and submission closing element </submission> may only occur once in the file, 
and all submission data must be between the opening and closing elements. The data in the 
opening submission element should match the text exactly or the file will be rejected for invalid 
format. 

4.3.3. File Audit Data 
The File Audit Data XML opening and closing elements are sub-elements of the <submission> 
element. The XML elements between the opening <file-audit-data> and the closing </file-audit-
data> are sub-elements of the <file-audit-data> element. The information in the File Audit Data 
is provided when the file is exported for information only. The information may be included in the 
file to be uploaded for tracking purposes, but is not required and will not be validated. 

4.3.4. Submission Period Dates 
The Submission Period Dates XML elements are sub-elements of the <submission> element. 
The information in the Submission Period Dates will be provided when the file is exported for 
information only. The information may be included in the file to be uploaded if the creator 
desires the information for tracking purposes, but the data is not required and will not be 
validated. 

4.3.5. Group Identification 
The Group Identification indicates the start of the patient data and includes the Primary 
Taxpayer Identification Number for ACO GPROs and the Taxpayer Identification Number for 
PQRS GPROs. All data for the patients in the group must follow the identification number and 
must be included between the opening <web-interface> element and the closing </web-
interface> element. 

ACO GPROS: The Primary Taxpayer Identification Number in the file must match the Primary 
Taxpayer Identification Number associated to the Individuals Authorized Access to CMS 
Computer Services (IACS) ID of the user submitting the file. 

PQRS GPRO: The Taxpayer Identification Number in the file must match the Taxpayer 
Identification Number associated to the Individuals Authorized Access to CMS Computer 
Services (IACS) ID of the user submitting the file. 

The opening <patient> element and the closing </patient> element are used for each patient in 
the file. All data for each patient must be between an opening <patient> and closing </patient> 
element, but the <patient> elements may be repeated as often as necessary for additional 
patients. 

The <web-interface >, </web-interface >, <patient>, and </patient> tags are opening and closing 
tags and do not contain data. 
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The table below shows the appropriate XML format with a sample TIN for the Group 
Identification TIN. 

Available Values Sample XML Tag Other Parameters 

Character <group-
tin>0000000000</group-tin> 

Include XML elements for 
patient data 

4.3.6. Patient Demographics 
The Patient Demographics is provided on export to aid in locating the patient’s medical record. 

The Medicare ID is the unique identifier for the patient, so it is required for each patient. The 
Medicare ID may only be used once for each patient in a Patients XML file. 

The Medical Record Number, Other Identifier, National Provider Identifiers (NPIs), Clinic 
Identifier, and General Comments may be provided to update the existing information or to 
provide additional information not available during the patient sampling. 

The patient’s First Name, Last Name, Gender, and Date of Birth cannot be updated using XML 
uploads. These values may only be modified using the Web Interface. 

The Patient Demographics XML includes elements for: 

• Medicare ID 

• Patient First Name 

• Patient Last Name 

• Patient Gender 

• Patient Birth Date 

• Medical Record Number 

• Other Identifier 

• National Provider Identifiers (NPIs) 

• Clinic Identifier 

• General Comments 

4.3.6.1. Medicare ID 

The Medicare ID must be provided in the patient data. The Medicare ID may only be used once 
per patient in the Patients XML file. If the Medicare ID is not in the database for the ACO’s 
Primary Taxpayer Identification Number or the GPRO’s Taxpayer Identification Number 
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provided in the XML file, the file will pass format validation, but the data associated to the invalid 
Medicare ID will not be processed. The Medicare ID is the unique identifier for the patient and 
as such is the primary key. 

The table below shows the appropriate XML format with a sample Medicare ID for the Medicare 
ID. 

Available Values Sample XML Tag Other Parameters 

Character <medicare-
id>000000000Z</medicare-id> 

Include XML elements for 
patient’s demographics or 
data for the disease module 
or patient care measure in 
which the patient is ranked 

4.3.6.2. Patient First Name 

The patient’s First Name as it appears in CMS’s records during the sampling process will be 
pre-populated during the initial load of patient data. The XML element containing the First 
Name will be provided when exporting the patient data, but should not be provided in the XML 
upload. If the XML element for the First Name is used, the tag and value will not be processed. 

The table below shows the appropriate XML format with a sample name for the First Name. 

4.3.6.3. Patient Last Name 

The patient’s Last Name as it appears in CMS’s records during the sampling process will be 
pre-populated during the initial load of patient data. The XML element containing the Last Name 
will be provided when exporting the patient data, but should not be provided in the XML upload. 
If the XML element for the Last Name is used, the tag and value will not be processed. 

The table below shows the appropriate XML format with a sample name for the Last Name. 

Available Values Sample XML Tag Other Parameters 

Character <patient-first-name>First</patient-
first-name> 

None, Export Only 

Available Values Sample XML Tag Other Parameters 

Character <patient-last-name>Last</patient-
last-name> 

None, Export Only 
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4.3.6.4. Patient Gender 

The patient’s Gender as it appears in CMS’s records during the sampling process will be pre-
populated during the initial load of patient data. The XML element containing the Gender will be 
provided when exporting the patient data, but should not be provided in the XML upload. If the 
XML element for the Gender is used, the tag and value will not be processed. 

The table below shows the available values and appropriate XML format for the Gender. 

4.3.6.5. Patient Birth Date 

The patient’s Birth Date as it appears in CMS’s records during the sampling process will be 
pre-populated during the initial load of patient data. The XML element containing the Birth Date 
will be provided when exporting the patient data, but should not be provided in the XML upload 
If the XML element for the Birth Date is used, the tag and value will not be processed. 

The table below shows the appropriate XML format for the Birth Date. 

4.3.6.6. Medical Record Number 

The Medical Record Number will not be pre-populated during the sampling process. The value 
may be added during the submission period. The Medical Record Number may be any value 
used by the group to identify the patient. 

Available Values Sample XML Tag Other Parameters 

1 = Male <gender>1</gender> None, Export Only 

2 = Female <gender>2</gender> None, Export Only 

3 = Unknown <gender>3</gender> None, Export Only 

Available Values Sample XML Tag Other Parameters 

Valid date between 
01/01/1900 and 
6/30/2013 

<birth-date>10/15/1935</birth-
date> 

None, Export Only 
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The table below shows the appropriate XML format for the Medical Record Number. 

Available Values Sample XML Tag Other Parameters 

Character <medical-record-
number>123XYZ</medical-record-
number> 

None 

-1 = Update to NULL <medical-record-number>-
1</medical-record-number> 

None 

4.3.6.7. Other Identifier 

The Other Identifier will not be pre-populated during the sampling process. The value may be 
added during the submission period. The Other Identifier may be any value used by the group 
to identify the patient. 

The table below shows the appropriate XML format for the other identifier. 

4.3.6.8. Provider NPIs 

Up to three Provider NPIs (National Provider Identifiers) may be pre-populated during the 
sampling process. NPIs may be updated during the submission period. The NPI in the XML file 
must currently exist in the database. The list of existing NPIs may be obtained by exporting the 
Provider XML file or the list may be viewed on the Web Interface. If the NPI does not exist in the 
group, the XML file will pass format validation, but the patient’s NPI data will not be updated and 
an error message will be generated. 

The table below shows the appropriate XML format for the Provider NPIs. 

Available Values Sample XML Tag Other Parameters 

Numeric <provider-
npi>1111111111</provider-npi> 

None 

-1 = Update to NULL <provider-npi>-1</provider-npi> None 

Available Values Sample XML Tag Other Parameters 

Character <other-id>A0001</other-id> None 

-1 = Update to NULL <other-id>-1</other-id> None 
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Available Values Sample XML Tag Other Parameters 

Numeric <provider-npi-
two>2222222222</provider-npi-
two> 

None 

-1 = Update to NULL <provider-npi-two>-1</provider-
npi-two> 

None 

Numeric <provider-npi-
three>3333333333</provider-npi-
three> 

None 

-1 = Update to NULL <provider-npi-three>-1</provider-
npi-three> 

None 

4.3.6.9. Clinic Identifier 

The Clinic Identifier will be pre-populated during the sampling process with the TIN for PQRS 
GPROs. The Clinic Identifier will be pre-populated during the sampling process with the 
Participating TIN or the CMS Certification Number (CCN) for ACO GPROs. The Clinic 
Identifier for the patient may be updated during the submission period. The Clinic Identifier in 
the XML file must currently exist in the database. The list of existing Clinic Identifiers may be 
obtained by exporting the Clinic XML file. If the Clinic Identifier does not exist in the group, the 
XML file will pass format validation, but the patient’s Clinic Identifier data will not be updated 
and an error message will be generated. 

The table below shows the appropriate XML format for the Clinic Identifier. 

4.3.6.10. General Comments 

The General Comments will not be pre-populated during the sampling process. The text may 
be added during the submission period. 

Available Values Sample XML Tag Other Parameters 

Numeric <clinic-identifier>45226</clinic-
identifier> 

None 

-1 = Update to NULL <clinic-identifier>-1</clinic-
identifier> 

None 
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The table below shows the appropriate XML format for the General Comments. 

4.3.7. Medical Record Found 
The Medical Record Found and if the patient is Not Qualified for Sample due to patient In 
Hospice, Moved out of Country, Deceased, or HMO Enrollment, the Reason and Date they 
were no longer qualified, is answered only once per patient. Medical Record Found contains 
three types of information: 

• Medical Record Found 

• Reason a patient is not qualified for the sample, if not qualified 

• Date the patient became ineligible for the sample, if not qualified 

The Medical Record Found value must be provided for all patients in order to mark the patient 
as either skipped or complete. 

If the patient is ranked in CARE-1, the values for the Medical Record Found, Reason and 
Date may also be set in the Patient Discharge XML file. If the patient is ranked in any disease 
module, CARE measure, or PREV measure other than CARE-1, the values for the Medical 
Record Found, Reason and Date are set in the Patients XML file. It should be noted that the 
values should be the same for a patient ranked in both CARE-1 and any other disease module, 
CARE measure, or PREV measure if used in both files. If the values are different, the value in 
the last uploaded file will overwrite any previous values. 

4.3.7.1. Confirm Medical Record Found 

Determine if you are able to find the patient’s medical record. If the Medical Record Found is 
set to Yes, data must be provided for all required measures for the disease modules or patient 
care measures in which the patient is ranked. In addition to setting the Medical Record Found 
value, confirmation that the patient is qualified for the disease modules or patient care measures 
must be provided. 

If the medical record was not found for the patient, the patient will be skipped in all disease 
modules or patient care measures in which the patient is ranked. When the Medical Record 
Found is set to Medical Record Not Found, abstraction is complete for this patient and no 
other XML elements should be provided for this patient. 

If the medical record was found, but the patient is not qualified for the sample because they are 
in hospice, moved out of the country, are deceased, or enrolled in an HMO, the patient will be 

Available Values Sample XML Tag Other Parameters 

Text up to 250 characters <general-comments>Text for general 
comments</general-comments> 

None 

-1 = Update to NULL <general-comments>-1</general-
comments> 

None 
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skipped in all disease modules or patient care measures in which the patient is ranked. The 
reason the patient is not qualified for the sample and the date they became ineligible must be 
provided. When the Medical Record Found is set to Not Qualified for Sample, and the 
Reason and Date have been provided, abstraction is complete for this patient and no other 
XML elements should be provided for this patient. 

The table below shows the available values and appropriate XML tags for Medical Record 
Found. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <medical-record-found>2</medical-
record-found> 

Include required confirmation 
and required measure 
elements for all disease 
modules, CARE measures, 
or PREV measures in which 
the patient is ranked to 
complete the patient’s data 

Do not include Medical 
Record Found Reason 
value and Medical Record 
Found  Date value 

3 = Medical Record Not 
Found 

<medical-record-found>3</medical-
record-found> 

Do not include Medical 
Record Found Reason 
value and Medical Record 
Found Date value or 
measure elements for this 
patient 

Patient is skipped in all 
disease modules, CARE 
measures, or PREV 
measures in which the 
patient is ranked 
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Available Values Sample XML Tag Other Parameters 

9 = Not Qualified for 
Sample 

<medical-record-found>9</medical-
record-found> 

Include Medical Record 
Found Reason value and 
Medical Record Found Date 
value 

Do not include measure 
elements for this patient 

Patient is skipped in all 
disease modules, CARE 
measures, or PREV 
measures in which the 
patient is ranked 

-1 = Update to NULL <medical-record-found>-1</medical-
record-found> 

None 

4.3.7.2. Provide the Reason the Patient is Not Qualified for Sample 

If the Medical Record Found value is set to Not Qualified for Sample, the reason must be 
provided for the patient to be marked as skipped. 

The table below shows the available values and appropriate XML format for the Not Qualified 
for Sample reasons. 

Available Values Sample XML Tag Other Parameters 

10 = In Hospice <medical-not-qualified-
reason>10</medical-not-qualified-
reason> 

Include the Medical 
Record Found value and 
Medical Record Found 
Date value 

Patient is skipped in all 
disease modules, CARE 
measures, or PREV 
measures in which the 
patient is ranked 
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Available Values Sample XML Tag Other Parameters 

11 = Moved out of 
Country 

<medical-not-qualified-
reason>11</medical-not-qualified-
reason> 

Include the Medical 
Record Found value and 
Medical Record Found 
Date value 

Patient is skipped in all 
disease modules, CARE 
measures, or PREV 
measures in which the 
patient is ranked 

12 = Deceased <medical-not-qualified-
reason>12</medical-not-qualified-
reason> 

Include the Medical 
Record Found value and 
Medical Record Found 
Date value 

Patient is skipped in all 
disease modules, CARE 
measures, or PREV 
measures in which the 
patient is ranked 

16 = HMO Enrollment <medical-not-qualified-
reason>16</medical-not-qualified-
reason> 

Include the Medical 
Record Found value and 
Medical Record Found 
Date value 

Patient is skipped in all 
disease modules, CARE 
measures, or PREV 
measures in which the 
patient is ranked 

-1 = Update to NULL <medical-not-qualified-reason>-
1</medical-not-qualified-reason> 

None 

4.3.7.3. Provide the Date the Patient Became Ineligible for the Sample 

If the patient is not qualified for the sample and the reason is in hospice, moved out of the 
country, or deceased, the date must be provided for the patient to be marked as skipped. Enter 
the date in MM/DD/YYYY format the patient became ineligible for the sample during the 
measurement period (if date unknown enter 12/31/2013) 

The table below shows the available values and appropriate XML format for the Not Qualified 
for Sample date. 
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4.3.8. Care Coordination/Patient Safety (CARE) 

4.3.8.1. Care Coordination/Patient Safety (CARE) 

There are two, separately sampled Care Coordination/Patient Safety measures. Because they 
share a common screen on the Web Interface and are documented in one Supporting 
Document, the XML elements are in a common section. 

For patients ranked in CARE-1, the Patients XML contains the demographics, rank and 
confirmation for CARE-1, but does not contain the discharge dates. The discharge dates and 
associated elements are in the Patient Discharge XML. The CARE-2 confirmation may be done 
in either file, but if the values are different in the files, the last uploaded file will overwrite any 
previous value. 

The Patients XML CARE measures include elements for: 

• CARE-1 Confirmation 

• CARE-2 Confirmation 

• CARE-2: Screening for Future Falls Risk 

• CARE-1 and CARE-2 Comments 

• Additional details and codes for the measure confirmation and the individual measures 
can be found in the 2013_CARE_SupportingDocuments. 

4.3.8.2. CARE-1: Medication Reconciliation 

One value for abstraction is included for the CARE-1 measure in the Patients XML file: 

• Confirmation that the patient is qualified for the CARE-1 measure 

Available Values Sample XML Tag Other Parameters 

Valid date between 
01/01/2013 and 
12/31/2013 

<medical-not-qualified-
date>12/01/2013</medical-not-
qualified-date> 

Include the Medical 
Record Found value and 
Medical Record Found 
Reason value 

Patient is skipped in all 
 disease modules, CARE 
measures, or PREV 
measures  in which the 
patient is ranked 

-1 = Update to NULL <medical-not-qualified-date>-
1</medical-not-qualified-date> 

None 
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The medication reconciliation data for the CARE-1 measure is not included in the Patients XML, 
but may be provided in the Patient Discharge XML. Confirmation that the patient is qualified for 
the CARE-1 measure must be provided in either the Patients XML or the Patient Discharge 
XML. If the patient is not qualified for the CARE-1 measure, the measure data should not be 
provided. 

4.3.8.2.1. CARE-1 Confirmation 

CARE-1 Confirmation provides a way to skip the patient in the CARE-1 measure on a case by 
case basis. If the patient is ranked in any other disease module or patient care measure, the 
patient is only skipped in the CARE-1 measure, not in all disease modules or patient care 
measures in which they are ranked. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for the CARE-1 measure is done on a case by case basis, 
and requires prior approval from CMS. 

The table below shows the available values and appropriate XML format for CARE-1 
Confirmation. 

4.3.8.3. CARE-2: Falls: Screening for Future Fall Risk 

4.3.8.3.1. CARE-2: Falls: Screening for Future Fall Risk 

Two values for abstraction are included in the CARE-2 measure: 

• Confirmation that the patient is qualified for the CARE-2 measure (CARE-2 
Confirmation) 

• Indicator if the screening was performed if the patient is qualified (CARE-2: Screening 
for Future Fall Risk) 

Available Values Sample XML Tag Other Parameters 

2 = Yes <caremedcon-
confirmed>2</caremedcon-
confirmed> 

Provide the Discharge data using the 
Patient Discharge XML or Web 
Interface to complete the measure for 
this patient 

15 = No – Other 
CMS Approved 
Reason 

<caremedcon-
confirmed>15</caremedcon-
confirmed> 

Do not provide the Discharge data, 
patient is skipped for this measure 

-1 = Update to 
NULL 

<caremedcon-confirmed>-
1</caremedcon-confirmed> 

None 
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All values may not be required for the CARE-2 measure to be marked complete. Confirmation 
that the patient is qualified for the measure must be provided. If the patient is qualified for the 
measure, all required values for the CARE-2 measure must be provided before the system can 
mark the patient as complete in the CARE-2 measure. If the patient is not qualified for the 
measure, the patient is skipped in the measure and the measure data should not be provided. 

4.3.8.3.2. CARE-2 Confirmation 

CARE-2 Confirmation provides a way to skip the patient in the CARE-2 measure on a case by 
case basis. If the patient is ranked in any other disease module, CARE measure, or PREV 
measure, the patient is only skipped in the CARE-2 measure, not in all modules or patient care 
measures in which they are ranked. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for CARE-2 is done on a case by case basis, and requires 
prior approval from CMS. 

The table below shows the available values and appropriate XML format for CARE-2 
Confirmation. 

4.3.8.3.3. CARE-2: Screening for Future Fall Risk 

Determine if the patient was screened for future fall risk at least once within 12 months. 

The table below shows the available values and appropriate XML format for Screening for 
Future Falls Risk. 

Available Values Sample XML Tag Other Parameters 

1 = No <falls-screening>1</falls-
screening> 

None, measure is complete 
for this patient 

Available Values Sample XML Tag Other Parameters 

2 = Yes <carefalls-confirmed>2</carefalls-
confirmed> 

Provide the Screening for 
Future Fall Risk value to 
complete the measure for this 
patient 

15 = No – Other CMS 
Approved Reason 

<carefalls-confirmed>15</carefalls-
confirmed> 

Do not provide the Screening 
for Future Fall Risk value, 
patient is skipped for this 
measure 

-1 = Update to NULL <carefalls-confirmed>-1</carefalls-
confirmed> 

None 
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Available Values Sample XML Tag Other Parameters 

2 = Yes <falls-screening>2</falls-
screening> 

None, measure is complete 
for this patient 

4 = No – Medical Reasons <falls-screening>4</falls-
screening> 

None, measure is complete 
for this patient 

-1 = Update to NULL <falls-screening>-1</falls-
screening> 

None 

4.3.8.4. Optional Comments for the CARE-1 and CARE-2 Measures 

The Optional Comments for the CARE measures can be used to provide additional information 
for the patient related to CARE-1 and CARE-2. Comments for CARE-1 can also be provided in 
the Patient Discharge file. It should be noted that the comments should be the same for a 
patient ranked in both CARE-1 and CARE-2. If the comments are different, the comments in the 
last uploaded file will overwrite any previous comments. 

The table below the available values and appropriate XML format for the CARE Optional 
Comments. 

4.3.9. Coronary Artery Disease (CAD) 
The Coronary Artery Disease (CAD) module includes elements for: 

• CAD Confirmed 

• CAD-2: Lipid Control 

• CAD-7: Diabetes/LVSD and ACE-I/ARB 

• CAD Comments 

Additional details and codes for the diagnosis confirmation and the individual measures can be 
found in the 2013_CAD_SupportingDocuments. 

Available Values Sample XML Tag Other Parameters 

Text up to 250 characters <care-comments>Text for 
comment</care-comments> 

None 

-1 = Update to NULL <care-comments>-1</care-
comments> 

None 



XML Specifications 

GPRO-ACO XML Specification v2.0 31 PQRS PY2013 12/20/2013 

4.3.9.1. CAD Confirmed 

Determine if the patient has a documented diagnosis of CAD (active or history of) at any time in 
the patient’s history up through the last day of the measurement period. 

In addition to indicating the medical record was found for the patient, the diagnosis of coronary 
artery disease must be confirmed. If the diagnosis can be confirmed for the patient, all required 
values for the CAD measures must be provided before the system can mark the patient as 
complete in the CAD module. 

CAD Confirmed also provides a way to skip the patient in the CAD module. If the patient is 
ranked in any other disease module, CARE measure, or PREV measure, the patient is only 
skipped in the CAD module, not in all modules or patient care measures in which they are 
ranked. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for the CAD module is done on a case by case basis, and 
requires prior approval from CMS. 

If the diagnosis of CAD cannot be confirmed, or the patient is not qualified for the sample for a 
CMS approved reason, the values for the CAD measures should not be provided. 

The table below shows the available values and appropriate XML tags for CAD Confirmed. 

4.3.9.2. CAD-2: Lipid Control 

One value for abstraction is included in the CAD-2 measure: LDL-C Control/Plan of Care 

Available Values Sample XML Tag Other Parameters 

2 = Yes <cad-confirmed>2</cad-confirmed> Include required CAD 
measure elements to 
complete the patient’s data 
for CAD 

8 = Not Confirmed <cad-confirmed>8</cad-confirmed> Do not include CAD measure 
elements for this patient, 
patient is skipped in this 
module 

15 = No – Other CMS 
Approved Reason 

<cad-confirmed>15</cad-confirmed> Do not include CAD measure 
elements for this patient, 
patient is skipped in this 
module 

-1 = Update to NULL <cad-confirmed>-1</cad-confirmed> None 
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The value for LDL-C Control/Plan of Care is required for the CAD-2 measure to be marked 
complete. 

4.3.9.2.1. Determine if the Patient’s LDL-C is in Control or there is a Plan of Care 

Determine if the patient had an LDL-C test result < 100 mg/dL OR An LDL-C test result ≥ 100 
mg/dL AND had a documented plan of care to achieve LDL-C < 100 mg/dL including, at a 
minimum, the prescription of a statin during the measurement period. 

Prescribed may include a prescription given to the patient for statin at one or more visits within 
the measurement period OR patient already taking a statin as documented in the current 
medication list. 

If there is more than one LDL-C test performed, use the most current test or recent value. 

The table below shows the available values and appropriate XML format for LDL-C 
Control/Plan of Care. 

Available Values Sample XML Tag Other Parameters 

1 = No <cad-ldlc-control>1</cad-ldlc-
control> 

None, measure is complete 
for this patient 

2 = Yes <cad-ldlc-control>2</cad-ldlc-
control> 

None, measure is complete 
for this patient 

4 = No – Medical Reasons <cad-ldlc-control>4</cad-ldlc-
control> 

None, measure is complete 
for this patient 

5 = No – Patient Reasons <cad-ldlc-control>5</cad-ldlc-
control> 

None, measure is complete 
for this patient 

6 = No – System Reasons <cad-ldlc-control>6</cad-ldlc-
control> 

None, measure is complete 
for this patient 

-1 = Update to NULL <cad-ldlc-control>-1</cad-ldlc-
control> 

None 

4.3.9.3. CAD-7: Angiotensin-Converting Enzyme (ACE) Inhibitor or Angiotensin Receptor Blocker 
(ARB) Therapy 

Three values for abstraction are included in the CAD-7 measure: 

• Confirmation that the patient has Diabetes 

• Confirmation that the patient has LVSD 
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• Indicator that the patient was prescribed ACE-I/ARB Therapy 

All values may not be required for the CAD-7 measure to be marked complete. Both Has 
Diabetes and Has LVSD values must be provided. If the value for either Has Diabetes or Has 
LVSD is Yes, a value for ACE-I/ARB must be provided. If both Has Diabetes and Has LVSD 
are No, a value is not required for ACE-I/ARB. 

4.3.9.3.1. Determine if the Patient Has Diabetes 

Determine if the patient has diabetes. 

The table below shows the available values and appropriate XML format for Has Diabetes. 

4.3.9.3.2. Determine if the Patient Has LVSD 

Determine if the patient has LVSD (LVEF < 40% or documented as moderate to severe). If the 
patient has ever had an LVEF < 40% or has had a documented LVEF as moderate to severe 
answer Yes. 

The table below shows the available values and appropriate XML format for Has LVSD. 

Available Values Sample XML Tag Other Parameters 

1 = No <cad-lvsd>1</cad-lvsd> If Has Diabetes is also No, do 
not provide the ACE-I/ARB 
value, measure is complete 
for this patient 

2 = Yes <cad-lvsd>2</cad-lvsd> Provide the ACE-I/ARB value 
and the Has Diabetes value 
to complete the measure for 
this patient 

Available Values Sample XML Tag Other Parameters 

1 = No <cad-diabetes>1</cad-diabetes> If Has LVSD is also No, do 
not provide the ACE-I/ARB 
value, measure is complete 
for this patient 

2 = Yes <cad-diabetes>2</cad-diabetes> Provide the ACE-I/ARB 
value and the Has LVSD 
value to complete the 
measure for this patient 

-1 = Update to NULL <cad-diabetes>-1</cad-diabetes> None 
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Available Values Sample XML Tag Other Parameters 

-1 = Update to NULL <cad-lvsd>-1</cad-lvsd> None 

4.3.9.3.3. Determine if the Patient was Prescribed ACE-I/ARB 

Determine if the patient was prescribed ACE inhibitor or ARB therapy at any time during the 
measurement period. Prescribed may include prescription given to the patient for ACE inhibitor 
or ARB therapy at one or more visits in the measurement period OR patient is already taking 
ACE inhibitor or ARB therapy as documented in the current medication list. 

The table below shows the available values and appropriate XML format for ACE-I/ARB. 

Available Values Sample XML Tag Other Parameters 

1 = No <cad-acearb>1</cad-acearb> Provide the Has Diabetes 
value and the Has LVSD 
value to complete the 
measure for this patient 

2 = Yes <cad-acearb>2</cad-acearb> Provide the Has Diabetes 
value and the Has LVSD 
value to complete the 
measure for this patient 

4 = No – Medical 
Reasons 

<cad-acearb>4</cad-acearb> Provide the Has Diabetes 
value and the Has LVSD 
value to complete the 
measure for this patient 

5 = No – Patient 
Reasons 

<cad-acearb>5</cad-acearb> Provide the Has Diabetes 
value and the Has LVSD 
value to complete the 
measure for this patient 

6 = No – System 
Reasons 

<cad-acearb>6</cad-acearb> Provide the Has Diabetes 
value and the Has LVSD 
value to complete the 
measure for this patient 

-1 = Update to NULL <cad-acearb>-1</cad-acearb> None 
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4.3.9.4. Optional Comments for the CAD Module 

The Optional Comments for the CAD module can be used to provide additional information for 
the patient related to CAD. 

The table below shows the available values and appropriate XML format for the CAD Optional 
Comments. 

4.3.10. Diabetes Mellitus (DM) 
The Diabetes Mellitus (DM) module includes elements for: 

• DM Confirmed 

• DM-2 and DM-15: Most Recent HbA1c 

• DM-13: High Blood Pressure Control 

• DM-14: Most Recent LDL-C Result 

• DM-16: IVD/Aspirin Use 

• DM-17: Tobacco Non-Use 

• DM Comments 

• Additional details and codes for the diagnosis confirmation and the individual measures 
can be found in the 2013_DM_SupportingDocuments. 

4.3.10.1. DM Confirmed 

Determine if the patient has a documented history of DM during the measurement period or the 
year prior to the measurement period. 

In addition to indicating the medical record was found for the patient, the diagnosis of diabetes 
mellitus must be confirmed. If the diagnosis can be confirmed for the patient, all required values 
for the DM measures must be provided before the system can mark the patient as complete in 
the DM module. 

Available Values Sample XML Tag Other Parameters 

Text up to 250 characters <cad-comments>Text for 
comment</cad-comments> 

None 

-1 = Update to NULL <cad-comments>-1</cad-
comments> 

None 
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DM Confirmed also provides a way to skip the patient in the DM module. If the patient is ranked 
in any other disease module, CARE measure, or PREV measure, the patient is only skipped in 
the DM module, not in all modules or patient care measures in which they are ranked. 

A patient may be skipped in the DM module if the diagnosis cannot be confirmed for Medical 
Reasons. The patient may be skipped for Medical Reasons only in the DM module. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, HMO Enrollment, or Medical 
Reasons. The use of No – Other CMS Approved Reason for the DM module is done on a 
case by case basis, and requires prior approval from CMS. 

If the diagnosis of DM cannot be confirmed, the diagnosis cannot be confirmed for medical 
reasons, or the patient is not qualified for the sample for a CMS approved reason, the values for 
the DM measures should not be provided. 

The table below shows the available values and appropriate XML tags for DM Confirmed. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <dm-confirmed>2</dm-confirmed> Include required DM measure 
elements to complete the 
patient’s data for DM 

8 = Not Confirmed <dm-confirmed>8</dm-confirmed> Do not include DM measure 
elements for this patient, 
patient is skipped in this 
module 

13 = Not Confirmed - 
Medical Reasons 

<dm-confirmed>13</dm-confirmed> Do not include DM measure 
elements for this patient, 
patient is skipped in this 
module 

15 = No – Other CMS 
Approved Reason 

<dm-confirmed>15</dm-confirmed> Do not include DM measure 
elements for this patient, 
patient is skipped in this 
module 

-1 = Update to NULL <dm-confirmed>-1</dm-confirmed> None 

4.3.10.2. DM-2: Hemoglobin A1c Poor Control and DM-15: Hemoglobin A1c Control (<8%) 

Three values for abstraction are included the DM-2 and DM-15 measure: 

• Confirmation that HbA1c test was performed 

• The most recent date the blood was drawn for the HbA1c 



XML Specifications 

GPRO-ACO XML Specification v2.0 37 PQRS PY2013 12/20/2013 

• The most recent HbA1c value 

DM-2 and DM-15 are separate measures for performance calculations, but only one set of data 
is to be provided. 

All values may not be required for the DM-2 and DM-15 measures to be marked as complete 
The HbA1c Test value must be provided. If an HbA1c test was not performed, a value should 
not be provided for the date and test result. If an HbA1c test was performed, the date and test 
result must have a value provided. The DM-2 and DM-15 measures will be marked as complete 
for the patient when all required fields have a value provided. 

4.3.10.2.1. Determine if an HbA1c test was performed 

Determine if the patient had one or more HbA1c tests performed during the measurement 
period. 

The table below shows the available values and appropriate XML format for HbA1c Test. 

4.3.10.2.2. Determine Date Blood was Drawn for the HbA1c 

If the HbA1c test was performed, provide the most recent date the blood was drawn for the 
HbA1c. 

The table below shows the available values and appropriate XML format for the date the most 
recent date the blood was drawn for the HbA1c. 

Available Values Sample XML Tag Other Parameters 

Valid date between 
01/01/2013 and 12/31/2013 
in format MM/DD/YYYY 

<dm-hba1c-
date>02/14/2013</dm-hba1c-
date> 

Provide the HbA1c Test 
value and HbA1c Result 
value to complete the 
measure for this patient 

Available Values Sample XML Tag Other Parameters 

1 = No <dm-hba1c-test>1</dm-hba1c-
test> 

Do not provide the HbA1c 
Date value and  HbA1c 
Result value, measure is 
complete for this patient 

2 = Yes <dm-hba1c-test>2</dm-hba1c-
test> 

Provide the HbA1c Date 
value and HbA1c Result 
value to complete the 
measure for this patient 

-1 = Update to NULL <dm-hba1c-test>-1</dm-hba1c-
test> 

None 
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Available Values Sample XML Tag Other Parameters 

-1 = Update to NULL <dm-hba1c-date>-1</dm-
hba1c-date> 

None 

4.3.10.2.3. Determine HbA1c Test Result 

If the HbA1c test was performed, provide the most recent HbA1c value OR if test was 
performed but result is not documented, provide a "0" (zero) for the value. 

The table below shows the available values and appropriate XML format for the HbA1c test 
result value. 

Available Values Sample XML Tag Other Parameters 

0-25 with one or two 
optional decimal places 
(XX.XX) 

<dm-hba1c-value>6.8</dm-hba1c-
value> 

Provide the HbA1c Test 
value and HbA1c Date 
value to complete the 
measure for this patient 

-1 = Update to NULL <dm-hba1c-value>-1</dm-hba1c-
value> 

None 

4.3.10.3. DM-13: High Blood Pressure Control 

Four values for abstraction are included in the DM-13 measure: 

• Confirmation that the blood pressure measurement was documented 

• The date of the most recent blood pressure 

• The systolic value 

• The diastolic value 

All values may not be required for the DM-13 measure to be marked as complete. The Blood 
Pressure Documented value must be provided. If the patient’s blood pressure was not 
documented, a value should not be provided for the date, systolic, and diastolic values. If 
patient’s blood pressure was documented, the date, systolic, and diastolic values must be 
provided. The DM-13 measure will be marked as complete for the patient when all required 
fields have a value provided. 

4.3.10.3.1. Determine if the Blood Pressure was Documented 

Determine if the patient’s most recent blood pressure during the measurement period was 
documented. 
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The table below shows the available values and appropriate XML format for Blood Pressure 
Documented. 

4.3.10.3.2. Determine Date Blood Pressure was Documented 

If the blood pressure measurement was documented, provide date of the most recent blood 
pressure. 

The table below shows the available values and appropriate XML format for the most recent 
Blood Pressure Date. 

Available Values Sample XML Tag Other Parameters 

Valid date between 
01/01/2013 and 12/31/2013 
in format MM/DD/YYYY 

<dm-bp-date>06/03/2013</dm-
bp-date> 

Provide the Blood 
Pressure Documented 
value, Systolic value, and 
Diastolic value to complete 
the measure for this patient 

-1 = Update to NULL <dm-bp-date>-1</dm-bp-date> None 

4.3.10.3.3. Determine Systolic Value for Most Recent Blood Pressure 

If the blood pressure was documented, provide the systolic blood pressure in mmHg. 

The table below shows the available values and appropriate XML format for the Blood 
Pressure Systolic. 

Available Values Sample XML Tag Other Parameters 

1 = No <dm-recent-bp>1</dm-recent-bp> Do not provide the Blood 
Pressure Date value, 
Systolic value, and 
Diastolic value, measure is 
complete for this patient 

2 = Yes <dm-recent-bp>2</dm-recent-bp> Provide the Blood 
Pressure Date value, 
Systolic value, and 
Diastolic value to complete 
the measure for this patient 

-1 = Update to NULL <dm-recent-bp>-1</dm-recent-bp> None 
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4.3.10.3.4. Determine Diastolic Value for Most Recent Blood Pressure 

If the blood pressure measurement was documented, provide the diastolic blood pressure 
recorded in mmHg. 

The table below shows the available values and appropriate XML format for the Blood 
Pressure Diastolic. 

Available Values Sample XML Tag Other Parameters 

0 to 200 <dm-bp-diastolic>90</dm-bp-
diastolic> 

Provide the Blood Pressure 
Documented value, Blood 
Pressure Date value, and 
Systolic value to complete 
the measure for this patient 

-1 = Update to NULL <dm-bp-diastolic>-1</dm-bp-
diastolic> 

None 

4.3.10.4. DM-14: Low Density Lipoprotein (LDL-C) Control 

Three values for abstraction are included in the DM-14 measure: 

• Confirmation that the LDL-C test was performed 

• The most recent date the blood was drawn for LDL-C 

• The most recent LDL-C value 

All values may not be required for the DM-14 measure to be marked as complete. The LDL-C 
Test value must be provided. If an LDL-C test was not performed, a value for the date and 
result should not be  provided. If an LDL-C test was performed, a value for the date and test 
result must be provided. The DM-14 measure will be marked as complete for the patient when 
all required values are provided. 

Available Values Sample XML Tag Other Parameters 

0 to 350 <dm-bp-systolic>140</dm-bp-
systolic> 

Provide the Blood 
Pressure Documented 
value, Blood Pressure 
Date value, and Diastolic 
value to complete the 
measure for this patient 

-1 = Update to NULL <dm-bp-systolic>-1</dm-bp-
systolic> 

None 
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4.3.10.4.1. Determine if an LDL-C test was performed 

Determine if the patient had one or more LDL-C tests during the measurement period. 

The table below shows the available values and appropriate XML format for the confirmation of 
an LDL-C Test. 

4.3.10.4.2. Determine Date Blood was Drawn for the LDL-C Test 

If the LDL-C Test was performed, provide the most recent date the blood was drawn for the 
LDL-C. 

The table below shows the available values and appropriate XML format for the most recent 
date the blood was drawn for the LDL-C Test. 

Available Values Sample XML Tag Other Parameters 

Valid date between 
01/01/2013 and 12/31/2013 
in format MM/DD/YYYY 

<dm-ldlc-
date>02/14/2013</dm-ldlc-
date> 

Provide the LDL-C Test 
value and LDL-C Result 
value to complete the 
measure for this patient 

-1 = Update to NULL <dm-ldlc-date>-1</dm-ldlc-
date> 

None 

4.3.10.4.3. Determine LDL_C Test Result 

If the LDL-C Test was performed, provide the most recent LDL-C result value. If test was 
performed but result is not documented, provide a 0 (zero) value. If the laboratory was unable to 
calculate the LDL-C value due to high triglycerides, provide a 0 (zero) value. If the test result is 
labeled "unreliable” and a result is provided, also provide 0 (zero) value. Do not enter a ratio as 
a value (it is not a valid value). 

Available Values Sample XML Tag Other Parameters 

1 = No <dm-ldlc-test>1</dm-ldlc-test> Do not provide the LDL-C 
Date value and LDL-C 
Result value, measure is 
complete for this patient 

2 = Yes <dm-ldlc-test>2</dm-ldlc-test> Provide the LDL-C Date 
value and LDL-C Result 
value to complete the 
measure for this patient 

-1 = Update to NULL <dm-ldlc-test>-1</dm-ldlc-test> None 
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A calculated LDL may be used for LDL-C screening and control indicators. 

The table below shows the available values and appropriate XML format for the LDL-C test 
result value. 

4.3.10.5. DM-16: Daily Aspirin or Antiplatelet Medication Use for Patients with Diabetes and Ischemic 

Two values for abstraction are included in the DM-16 measure: 

• Confirmation that the patient has IVD 

• Indicator of daily aspirin or antiplatelet use 

All values may not be required for the DM-16 measure to be marked complete. The Has IVD 
value must be provided. If the patient has IVD, a value for Daily Aspirin Use must be provided. 
If the patient does not have IVD, a value should not be provided for Daily Aspirin Use. The 
DM-16 measure will be marked as complete for the patient when all required values are 
provided. 

4.3.10.5.1. Determine if the Patient has IVD 

Determine if the patient has a documented history of Ischemic Vascular Disease (IVD). 

The table below shows the available values and appropriate XML format for Has IVD. 

Available Values Sample XML Tag Other Parameters 

1 = No <dm-ivd>1</dm-ivd> Do not provide the Daily 
Aspirin Use value, measure 
is complete for this patient 

2 = Yes <dm-ivd>2</dm-ivd> Provide the Daily Aspirin 
Use value to complete the 
measure for this patient 

-1 = Update to NULL <dm-ivd>-1</dm-ivd> None 

Available Values Sample XML Tag Other Parameters 

0 to 500 <dm-ldlc-value>129</dm-ldlc-
value> 

Provide the LDL-C Test 
value and LDL-C Date 
value to complete the 
measure for this patient 

-1 = Update to NULL <dm-ldlc-value>-1</dm-ldlc-value> None 
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4.3.10.5.2. Determine Daily Aspirin Use 

If the patient has IVD, determine if the patient takes a daily aspirin or antiplatelet medication 
during the measurement period. 

The table below shows the available values and appropriate XML format for Daily Aspirin Use 
or Antiplatelet Medication. 

4.3.10.6. DM-17: Tobacco Non-Use 

Determine if patient was screened and identified as a tobacco non-user during the 
measurement period. 

The table below shows the available values and appropriate XML format for Tobacco Non-Use. 

Available Values Sample XML Tag Other Parameters 

1 = No 

Screened and identified as a 
tobacco user 

<dm-tobacco>1</dm-tobacco None, measure is complete 
for this patient 

2 = Yes 

Screened and identified as a 
tobacco non-user 

<dm-tobacco>2</dm-
tobacco> 

None, measure is complete 
for this patient 

14 = Not Screened <dm-tobacco>14</dm-
tobacco 

None, measure is complete 
for this patient 

Available Values Sample XML Tag Other Parameters 

1 = No <dm-aspirin>1</dm-aspirin> Provide the Has IVD value 
to complete the measure for 
this patient 

2 = Yes <dm-aspirin>2</dm-aspirin> Provide the Has IVD value 
to complete the measure for 
this patient 

4 = No – Medical 
Reasons 

<dm-aspirin>4</dm-aspirin> Provide the Has IVD value 
to complete the measure for 
this patient 

-1 = Update to NULL <dm-aspirin>-1</dm-aspirin> None 
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Available Values Sample XML Tag Other Parameters 

-1 = Update to NULL <dm-tobacco>-1</dm-tobacco None 

4.3.10.7. Optional Comments for the DM Module 

The Optional Comments for the DM module can be used to provide additional information for 
the patient related to DM. 

The table below shows the available values and appropriate XML format for the DM Optional 
Comments. 

4.3.11. Heart Failure (HF) 
The Heart Failure (HF) module includes elements for 

• HF Confirmed 

• HF-6: LVSD and BB 

• HF Comments 

Additional details and codes for the diagnosis confirmation and the individual measures can be 
found in the 2013_HF_SupportingDocuments. 

4.3.11.1. HF Confirmed 

Determine if the patient has a documented diagnosis of HF (active or history of) at any time in 
the patient’s history up through the last day of the measurement period. 

In addition to indicating the medical record was found for the patient, the diagnosis of heart 
failure must be confirmed. If the diagnosis can be confirmed for the patient, all required values 
for the HF measures must be provided before the system can mark the patient as complete in 
the HF module. 

HF Confirmed also provides a way to skip the patient in the HF module. If the patient is ranked 
in any other disease module, CARE measure, or PREV measure, the patient is only skipped in 
the HF module, not in all modules or patient care measures in which they are ranked. 

Available Values Sample XML Tag Other Parameters 

Text up to 250 characters <dm-comments>Text for 
comment</dm-comments> 

None 

-1 = Update to NULL <dm-comments>-1</dm-
comments> 

None 
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The No – Other CMS Approved Reason may be used  if the patient is not qualified for a 
reason other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The 
use of No – Other CMS Approved Reason for the HF module is done on a case by case basis, 
and requires prior approval from CMS. 

If the diagnosis of HF cannot be confirmed, or the patient is not qualified for the sample for a 
CMS approved reason, the values for the HF measures should not be provided. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <hf-confirmed>2</hf-confirmed> Include required HF measure 
elements to complete the 
patient’s data for HF 

8 = Not Confirmed <hf-confirmed>8</hf-confirmed> Do not include HF measure 
elements for this patient, 
patient is skipped in this 
module 

15 = No - Other CMS 
Approved Reason 

<hf-confirmed>15</hf-confirmed> Do not include HF measure 
elements for this patient, 
patient is skipped in this 
module 

-1 = Update to NULL <hf-confirmed>-1</hf-confirmed> None 

4.3.11.2. HF-6: Beta-Blocker Therapy for Left Ventricular Systolic Dysfunction (LVSD) 

Two values for abstraction are included in the HF-6 measure: 

• Confirmation that the patient has LVSD 

• Indicator that the patient was prescribed beta-blocker therapy 

All values may not be required for the HF-6 measures to be marked complete. The Has LVSD 
value must be provided. If the patient has LVSD, a value for Beta-Blocker must be provided. If 
the patient does not have LVSD, a value should not be provided for Beta-Blocker. The HF-6 
measure will be marked as complete for the patient when all required values are provided. 

4.3.11.2.1. Determine if the Patient has LVSD 

Determine if the patient has LVSD (LVEF < 40% or documented as moderate or severe). If the 
patient has ever had an LVEF < 40% or has had a documented LVEF as moderate or severe 
answer Yes. 

The table below shows the available values and appropriate XML format for Has LVSD. 
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Available Values Sample XML Tag Other Parameters 

1 = No <hf-lvsd>1</hf-lvsd> Do not provide the Beta-
Blocker value, measure is 
complete for this patient 

2 = Yes <hf-lvsd>2</hf-lvsd> Provide the Beta Blocker 
value to complete the 
measure for this patient 

-1 = Update to NULL <hf-lvsd>-1</hf-lvsd> None 

4.3.11.2.2. Determine if Beta Blocker was Prescribed 

If the patient has LVSD, determine if the patient was prescribed beta-blocker therapy at any 
time during the measurement period. 

The table below shows the available values and appropriate XML format for Beta-Blocker 
Therapy. 

Available Values Sample XML Tag Other Parameters 

1 = No <hf-beta-blocker>1</hf-beta-
blocker> 

Provide the Has LVSD value 
to complete the measure for 
this patient 

2 = Yes <hf-beta-blocker>2</hf-beta-
blocker> 

Provide the Has LVSD value 
to complete the measure for 
this patient 

4 = No – Medical Reasons <hf-beta-blocker>4</hf-beta-
blocker> 

Provide the Has LVSD value 
to complete the measure for 
this patient 

5 = No – Patient Reasons <hf-beta-blocker>5</hf-beta-
blocker> 

Provide the Has LVSD value 
to complete the measure for 
this patient 

6 = No – System Reasons <hf-beta-blocker>6</hf-beta-
blocker> 

Provide the Has LVSD value 
to complete the measure for 
this patient 

-1 = Update to NULL <hf-beta-blocker>-1</hf-beta-
blocker> 

None 
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4.3.11.3. Optional Comments for the HF Module 

The Optional Comments for the HF module can be used to provide additional information for 
the patient related to hypertension. 

The table below shows the available values and appropriate XML format for the HF Optional 
Comments. 

Available Values Sample XML Tag Other Parameters 

Text up to 250 characters <hf-comments>Text for 
comment</hf-comments> 

None 

-1 = Update to NULL <hf-comments>-1</hf-
comments> 

None 

4.3.12. Hypertension (HTN) 
The HTN module includes elements for 

• HTN Confirmed 

• HTN-2: Controlling High Blood Pressure 

• HTN Comments 

Additional details and codes for the diagnosis confirmation and the individual measures can be 
found in the 2013_HTN_SupportingDocuments. 

4.3.12.1. HTN Confirmed 

Determine if the patient has a documented history of HTN at any time in the patient’s history up 
through the last day of the measurement period. 

In addition to indicating the medical record was found for the patient, the diagnosis of 
hypertension must be confirmed. If the diagnosis can be confirmed for the patient, all required 
values for the HTN measures must be provided before the system can mark the patient as 
complete in the HTN module. 

HTN Confirmed also provides a way to skip the patient in the HTN module. If the patient is 
ranked in any other disease module, CARE measure, or PREV measure, the patient is only 
skipped in the HTN module, not in all modules or patient care measures in which they are 
ranked. 

The No – Other CMS Approved Reason may be used  if the patient is not qualified for a 
reason other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The 
use of No – Other CMS Approved Reason for the HTN module is done on a case by case 
basis, and requires prior approval from CMS. 
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If the diagnosis of HTN cannot be confirmed, or the patient is not qualified for the sample for a 
CMS approved reason, the values for the HTN measures should not be provided. 

The table below shows the available values and appropriate XML tags for HTN Confirmed. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <htn-confirmed>2</htn-confirmed> Include required HTN 
measure elements to 
complete the patient’s data 
for HTN 

8 = Not Confirmed <htn-confirmed>8</htn-confirmed> Do not include HTN measure 
elements for this patient, 
patient is skipped in this 
module 

15 = No - Other CMS 
Approved Reason 

<htn-confirmed>15</htn-confirmed> Do not include HTN measure 
elements for this patient, 
patient is skipped in this 
module 

-1 = Update to NULL <htn-confirmed>-1</htn-confirmed> None 

4.3.12.2. HTN-2: Controlling High Blood Pressure 

Four values for abstraction are included in the HTN-2 measure: 

• Confirmation that the blood pressure measurement was documented 

• The date the most recent blood pressure measurement was documented 

• The systolic value 

• The diastolic value 

All values may not be required for the HTN-2 measure to be marked as complete. The Blood 
Pressure Documented value must be provided. If the patient’s blood pressure was not 
documented, a value should not be provided for the date, systolic, and diastolic values. If 
patient’s blood pressure was documented, the date, systolic, and diastolic values must be 
provided. The HTN-2 measure will be marked as complete for the patient when all required 
fields have a value provided. 

4.3.12.2.1. Determine if the Blood Pressure was Documented 

Determine if the patient's most recent BP was documented during the measurement period. 
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The table below shows the available values and appropriate XML format for Blood Pressure 
Documented. 

Available Values Sample XML Tag Other Parameters 

1 = No <htn-recent-bp>1</htn-
recent-bp> 

Do not provide the Blood 
Pressure Date value, 
Systolic value, and Diastolic 
value, measure is complete 
for this patient 

2 = Yes <htn-recent-bp>2</htn-
recent-bp> 

Provide the Blood Pressure 
Date value, Systolic value, 
and Diastolic value to 
complete the measure for this 
patient 

4 = No – Medical Reasons <htn-recent-bp>4</htn-
recent-bp> 

Do not provide the Blood 
Pressure Date value, 
Systolic value, and Diastolic 
value, measure is complete 
for this patient 

-1 = Update to NULL <htn-recent-bp>-1</htn-
recent-bp> 

None 

4.3.12.2.2. Determine Date Blood Pressure Measurement was Documented 

If the blood pressure measurement was documented, provide the most recent blood pressure 
date. 

The table below shows the available values and appropriate XML format for the Blood 
Pressure Date. 

Available Values Sample XML Tag Other Parameters 

Valid date between 
01/01/2013 and 
12/31/2013 in format 
MM/DD/YYYY 

<htn-bp-date>02/15/2013</htn-bp-
date> 

Provide the Blood 
Pressure Documented 
value, Systolic value, and 
Diastolic value to complete 
the measure for this patient 

-1 = Update to NULL <htn-bp-date>-1</htn-bp-date> None 
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4.3.12.2.3. Determine Systolic Value for Most Recent Blood Pressure Measurement 

If the blood pressure measurement was documented, provide the systolic blood pressure 
recorded in mmHg. 

The table below shows the available values and appropriate XML format for the Blood 
Pressure Systolic. 

Available Values Sample XML Tag Other Parameters 

0 to 350 <htn-bp-systolic>120</htn-
bp-systolic> 

Provide the Blood Pressure 
Documented value, Blood 
Pressure Date value, and 
Diastolic value to complete 
the measure for this patient 

-1 = Update to NULL <htn-bp-systolic>-1</htn-bp-
systolic> 

None 

4.3.12.2.4. Determine Diastolic Value for Most Recent Blood Pressure Measurement 

If the blood pressure measurement was documented, provide the diastolic blood pressure 
recorded in mmHg. 

The table below shows the available values and appropriate XML format for the Blood 
Pressure Diastolic. 

Available Values Sample XML Tag Other Parameters 

0 to 200 <htn-bp-diastolic>80</htn-bp-
diastolic> 

Provide the Blood 
Pressure Documented 
value, Blood Pressure 
Date value, and Systolic 
value to complete the 
measure for this patient 

-1 = Update to NULL <htn-bp-diastolic>-1</htn-bp-
diastolic> 

None 

4.3.12.3. Optional Comments for the HTN Module 

The Optional Comments for the HTN module can be used to provide additional information for 
the patient related to hypertension. 

The table below shows the available values and appropriate XML format for the HTN Optional 
Comments. 
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4.3.13. Ischemic Vascular Disease (IVD) 
The Ischemic Vascular Disease (IVD) module contains elements for: 

• IVD Confirmed 

• IVD-1: Complete Lipid Profile and LDL-C Control 

• IVD-2: Use of Aspirin or Another Antithrombotic 

• IVD Comments 

Additional details and codes for the diagnosis confirmation and the individual measures can be 
found in the 2013_IVD_SupportingDocuments. 

4.3.13.1. IVD Confirmed 

Determine if the patient has a documented history of ischemic vascular disease (IVD), or was 
discharged alive for acute myocardial infarction (AMI), coronary artery bypass graft (CABG), or 
Percutaneous Coronary Interventions (PCI) at any time in the patient's history up through the 
last day of the measurement period. 

In addition to indicating the medical record was found for the patient, the diagnosis of ischemic 
vascular disease must be confirmed. If the diagnosis can be confirmed for the patient, all 
required values for the IVD measures must be provided before the system can mark the patient 
as complete in the IVD module. 

IVD Confirmed also provides a way to skip the patient in the IVD module. If the patient is 
ranked in any other disease module, CARE measure, or PREV measure, the patient is only 
skipped in the IVD module, not in all modules or patient care measures in which they are 
ranked. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for the IVD module is done on a case by case basis, and 
requires prior approval from CMS. 

If the diagnosis of IVD cannot be confirmed, or the patient is not qualified for the sample for a 
CMS approved reason, the values for the IVD measures should not be provided. 

The table below shows the available values and appropriate XML tags for IVD Confirmed. 

Available Values Sample XML Tag Other Parameters 

Text up to 250 characters <htn-comments>Text for 
comment</htn-comments> 

None 

-1 = Update to NULL <htn-comments>-1</htn-
comments> 

None 
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Available Values Sample XML Tag Other Parameters 

2 = Yes <ivd-confirmed>2</ivd-confirmed> Include required IVD 
measure elements to 
complete the patient’s data 
for IVD 

8 = Not Confirmed <ivd-confirmed>8</ivd-confirmed> Do not include IVD measure 
elements for this patient, 
patient is skipped in this 
module 

15 = No - Other CMS 
Approved Reason 

<ivd-confirmed>15</ivd-confirmed> Do not include IVD measure 
elements for this patient, 
patient is skipped in this 
module 

-1 = Update to NULL <ivd-confirmed>-1</ivd-confirmed> None 

4.3.13.2. IVD-1: Complete Lipid Profile and Low Density Lipoprotein (LDL-C) Control 

Three values for abstraction are included in the IVD-1 measure: 

• Confirmation that a lipid profile was performed 

• The most recent date the blood was drawn for lipid profile 

• The most recent LDL-C value 

All values may not be required for the IVD-1 measure to be marked as complete. The Lipid 
Profile Performed must be provided. If a lipid profile was not performed, a value for the date 
and result should not be provided. If a lipid profile was performed, the date and result values 
must be provided. The IVD-1 measure will be marked as complete for the patient when all 
required fields have a value provided. 

4.3.13.2.1. Determine if a Lipid Profile was Performed 

Determine if the patient had at least one lipid profile (or ALL component tests) during the 
measurement period. If LDL-C could not be calculated due to high triglycerides, count as 
complete lipid profile. 



XML Specifications 

GPRO-ACO XML Specification v2.0 53 PQRS PY2013 12/20/2013 

The table below shows the available values and appropriate XML format for Lipid Profile 
Performed. 

Available Values Sample XML Tag Other Parameters 

1 = No <ivd-lipid-performed>1</ivd-
lipid-performed> 

Do not provide the LDL-C 
Date Drawn value and LDL-C 
Result value, measure is 
complete for this patient 

2 = Yes <ivd-lipid-performed>2</ivd-
lipid-performed> 

Provide the LDL-C Date 
Drawn value and LDL-C 
Result value to complete the 
measure for this patient 

-1 = Update to NULL <ivd-lipid-performed>-1</ivd-
lipid-performed> 

None 

4.3.13.2.2. Determine Date Blood was Drawn for the Lipid Profile 

If the lipid profile was performed, provide the most recent date the blood was drawn for lipid 
profile. 

The table below shows the available values and appropriate XML format for the LDL-C Date 
Drawn. 

Available Values Sample XML Tag Other Parameters 

Valid date between 
01/01/2013 and 12/31/2013 
in format MM/DD/YYYY 

<ivd-lipid-
date>04/15/2013</ivd-lipid-
date> 

Provide the Lipid Profile 
Performed value and LDL-C 
Result value to complete the 
measure for this patient 

-1 = Update to NULL <ivd-lipid-date>-1</ivd-lipid-
date> 

None 

4.3.13.2.3. Determine Lipid Profile Result 

If the lipid profile was performed, provide the most recent LDL-C Result value. If the lipid profile 
was performed, but the result is not documented, provide a 0 (zero) value.  If laboratory is 
unable to calculate LDL-C value due to high triglycerides, provide a 0 (zero) value. If the test 
result is labeled "unreliable" and a result is provided, also provide a 0 (zero) value. Do not enter 
a ratio as a value (it is not a valid value) 
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The table below shows the available values and appropriate XML format for the LDL-C Result. 

4.3.13.3. IVD-2: Use of Aspirin or Other Antithrombotic 

Determine if the patient has documented use of aspirin or another antithrombotic during the 
measurement period. 

The table below shows the available values and appropriate XML format for Aspirin or Other 
Antithrombotic. 

Available Values Sample XML Tag Other Parameters 

1 = No <ivd-antithrombotic>1</ivd-
antithrombotic> 

None, measure is complete 
for this patient 

2 = Yes <ivd-antithrombotic>2</ivd-
antithrombotic> 

None, measure is complete 
for this patient 

-1 = Update to NULL <ivd-antithrombotic>-1</ivd-
antithrombotic> 

None 

4.3.13.4. Optional Comments for the IVD Module 

The Optional Comments for the IVD module can be used to provide additional information for 
the patient related to IVD. 

The table below shows the available values and appropriate XML format for the IVD Optional 
Comments. 

Available Values Sample XML Tag Other Parameters 

Text up to 250 characters <ivd-comments>Text for 
comment</ivd-comments> 

None 

Available Values Sample XML Tag Other Parameters 

0 to 500 <ivd-ldlc-value>129</ivd-ldlc-
value> 

Provide the  Lipid Profile 
Performed value and LDL-
C Date Drawn value to 
complete the measure for 
this patient 

-1 = Update to NULL <ivd-ldlc-value>-1</ivd-ldlc-value> None 
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Available Values Sample XML Tag Other Parameters 

-1 = Update to NULL <ivd-comments>-1</ivd-
comments> 

None 

4.3.14. Preventive Care (PREV) 
There are eight, separately sampled Preventive Care measures. Because they share a common 
screen on the Web Interface and are documented in one Supporting Document, the XML 
elements are in a common section. 

The PREV measures include elements for: 

• PREV-5: Breast Cancer Screening 

 PREV-5 Confirmation 

 PREV-5: Screening Performed 

• PREV-6: Colorectal Cancer Screening 

 PREV-6 Confirmation 

 PREV-6: Screening is Current 

• PREV-7: Influenza Immunization 

 PREV-7 Confirmation 

 PREV-7: Immunization Received 

• PREV-8: Pneumococcal Vaccination 

 PREV-8 Confirmation 

 PREV-8: Vaccination Received 

• PREV-9: Body Mass Index Screening and Follow-Up 

 PREV-9 Confirmation 

 PREV-9: Calculated BMI 

• PREV-10: Tobacco Use Screening and Cessation Intervention 

 PREV-10 Confirmation 

 PREV-10: Tobacco Use 

• PREV-11: Screening for High Blood Pressure and Follow-Up Documented 
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 PREV-11 Confirmation 

 PREV-11: Blood Pressure Screening 

• PREV-12: Depression Screening 

 PREV-12 Confirmation 

 PREV-12: Clinical Depression Screening  

• PREV Comments 

Additional details and codes for the measure confirmation and the individual measures can be 
found in the 2013_PREV_SupportingDocuments. 

4.3.14.1. PREV-5: Breast Cancer Screening 

Two values for abstraction are included in the PREV-5 measure: 

• Confirmation that the patient is qualified for the PREV-5 measure 

• Indicator if the screening was performed if the patient is qualified 

All values may not be required for the PREV-5 measure to be marked complete. Confirmation 
that the patient is qualified for the measure must be provided. If the patient is qualified for the 
measure, all required values for the PREV-5 measure must be provided before the system can 
mark the patient as complete in the PREV-5 measure. If the patient is not qualified for the 
measure, the patient is skipped in the measure and the measure quality data should not be 
provided. 

4.3.14.1.1. PREV-5 Confirmation 

In addition to indicating the medical record was found for the patient, confirmation that the 
patient is qualified for the PREV-5 measure must be provided. PREV-5 Confirmation provides 
a way to skip the patient in the PREV-5 measure on a case by case basis. If the patient is 
ranked in any other disease module, CARE measure, or PREV measure, the patient is only 
skipped in the PREV-5 measure, not in all modules or patient care measures in which they are 
ranked. 

The No – Other CMS Approved Reason may be used  if the patient is not qualified for a 
reason other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The 
use of No – Other CMS Approved Reason for the PREV-5 measure is done on a case by case 
basis, and requires prior approval from CMS. 
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The table below shows the available values and appropriate XML format for PREV-5 
Confirmation. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <pcmammogram-
confirmed>2</pcmammogram-
confirmed> 

Include required PREV-5 
measure elements to 
complete the patient’s data 
for PREV-5 

15 = No – Other CMS 
Approved Reason 

  

<pcmammogram-
confirmed>15</pcmammogram-
confirmed> 

Do not include PREV-5 
measure elements for this 
patient, patient is skipped in 
this measure 

-1 = Update to NULL <pcmammogram-confirmed>-
1</pcmammogram-confirmed> 

None 

4.3.14.1.2. PREV-5 Screening Performed 

Determine if a breast cancer screening was performed during the measurement period or year 
prior to the measurement period. 

The table below shows the available values and appropriate XML format for Screening 
Performed. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcmammogram>1</pcmammogram> None, measure is complete 
for this patient 

2 = Yes <pcmammogram>2</pcmammogram> None, measure is complete 
for this patient 

4 = No – Medical Reasons <pcmammogram>4</pcmammogram> None, measure is complete 
for this patient 

-1 = Update to NULL <pcmammogram>-1</pcmammogram> None 

4.3.14.2. PREV-6: Colorectal Cancer Screening 

Two values for abstraction are included in the PREV-6 measure: 

• Confirmation that the patient is qualified for the PREV-6 measure 
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• Indicator if the screening is current if the patient is qualified 

All values may not be required for the PREV-6 measure to be marked complete. Confirmation 
that the patient is qualified for the measure must be provided. If the patient is qualified for the 
measure, all required values for the PREV-6 measure must be provided before the system can 
mark the patient as complete in the PREV-6 measure. If the patient is not qualified for the 
measure, the patient is skipped in the measure and the measure quality data should not be 
provided. 

4.3.14.2.1. PREV-6 Confirmation 

In addition to indicating the medical record was found for the patient, confirmation that the 
patient is qualified for the PREV-6 measure must be provided. PREV-6 Confirmation provides 
a way to skip the patient in the PREV-6 measure on a case by case basis. If the patient is 
ranked in any other disease module, CARE measure, or PREV measure, the patient is only 
skipped in the PREV-6 module, not in all modules or patient care measures in which they are 
ranked. 

The No – Other CMS Approved Reason may be used  if the patient is not qualified for a 
reason other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The 
use of No – Other CMS Approved Reason for the PREV-6 measure is done on a case by case 
basis, and requires prior approval from CMS. 

The table below shows the available values and appropriate XML format for PREV-6 
Confirmation. 

4.3.14.2.2. PREV-6 Screening is Current 

Determine if colorectal cancer screening is current during the measurement period. 

The table below shows the available values and appropriate XML format for Screening is 
Current. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <pccolorectal-
confirmed>2</pccolorectal-
confirmed> 

Include required PREV-6 
measure elements to 
complete the patient’s data 
for PREV-6 

15 = No – Other CMS 
Approved Reason 

<pccolorectal-
confirmed>15</pccolorectal-
confirmed> 

Do not include PREV-6 
measure elements for this 
patient, patient is skipped in 
this measure 

-1 = Update to NULL <pccolorectal-confirmed>-
1</pccolorectal-confirmed> 

None 
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4.3.14.3. PREV-7: Influenza Immunization 

Two values for abstraction are included in the PREV-7 measure: 

• Confirmation that the patient is qualified for the PREV-7 measure 

• Indicator if the immunization was received if the patient is qualified 

All values may not be required for the PREV-7 measure to be marked complete. Confirmation 
that the patient is qualified for the measure must be provided. If the patient is qualified for the 
measure, all required values for the PREV-7 measure must be provided before the system can 
mark the patient as complete in the PREV-7 measure. If the patient is not qualified for the 
measure, the patient is skipped in the measure and the measure quality data should not be 
provided. 

4.3.14.3.1. PREV-7 Confirmation 

In addition to indicating the medical record was found for the patient, confirmation that the 
patient is qualified for the PREV-7 measure must be provided. PREV-7 Confirmation provides 
a way to skip the patient in the PREV-7 measure on a case by case basis. If the patient is 
ranked in any other all disease module, CARE measure, or PREV measure, the patient is only 
skipped in the PREV-7 measure, not in all modules or patient care measures in which they are 
ranked. 

The No – Other CMS Approved Reason may be used  if the patient is not qualified for a 
reason other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The 
use of No – Other CMS Approved Reason for the PREV-7 measure is done on a case by case 
basis, and requires prior approval from CMS. 

Available Values Sample XML Tag Other Parameters 

1 = No <pccolorectal>1</pccolorectal> None, measure is complete 
for this patient 

2 = Yes <pccolorectal>2</pccolorectal> None, measure is complete 
for this patient 

4 = No – Medical Reasons <pccolorectal>4</pccolorectal> None, measure is complete 
for this patient 

-1 = Update to NULL <pccolorectal>-1</pccolorectal> None 



XML Specifications 

GPRO-ACO XML Specification v2.0 60 PQRS PY2013 12/20/2013 

The table below shows the available values and appropriate XML format for PREV-7 
Confirmation. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <pcflushot-
confirmed>2</pcflushot-
confirmed> 

Include required PREV-7 
measure elements to 
complete the patient’s data for 
PREV-7 

15 = No – Other CMS 
Approved Reason 

<pcflushot-
confirmed>15</pcflushot-
confirmed> 

Do not include PREV-7 
measure elements for this 
patient, patient is skipped in 
this measure 

-1 = Update to NULL <pcflushot-confirmed>-
1</pcflushot-confirmed> 

None 

4.3.14.3.2. PREV-7 Immunization Received 

Determine if the patient was seen for a visit between October 1 and March 31 and received an 
influenza immunization OR reported previous receipt of an influenza immunization. For 2013, 
the flu season includes visits from October through December of the year prior to the 
measurement period (2012) or January through March of the measurement period (2013). 

The table below shows the available values and appropriate XML format for Influenza 
Immunization. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcflushot>1</pcflushot> None, measure is complete 
for this patient 

2 = Yes <pcflushot>2</pcflushot> None, measure is complete 
for this patient 

4 = No – Medical Reasons <pcflushot>4</pcflushot> None, measure is complete 
for this patient 

5 = No – Patient Reasons <pcflushot>5</pcflushot> None, measure is complete 
for this patient 

6 = No – System Reasons <pcflushot>6</pcflushot> None, measure is complete 
for this patient 
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Available Values Sample XML Tag Other Parameters 

-1 = Update to NULL <pcflushot>-1</pcflushot> None 

4.3.14.4. PREV-8: Pneumococcal Vaccination for Patients 65 and Older 

Two values for abstraction are included in the PREV-8 measure: 

• Confirmation that the patient is qualified for the PREV-8 measure 

• Indicator if the vaccination was received if the patient is qualified 

All values may not be required for the PREV-8 measure to be marked complete. Confirmation 
that the patient is qualified for the measure must be provided. If the patient is qualified for the 
measure, all required values for the PREV-8 measure must be provided before the system can 
mark the patient as complete in the PREV-8 measure. If the patient is not qualified for the 
measure, the patient is skipped in the measure and the measure quality data should not be 
provided. 

4.3.14.4.1. PREV-8 Confirmation 

In addition to indicating the medical record was found for the patient, confirmation that the 
patient is qualified for the PREV-8 measure must be provided. PREV-8 Confirmation provides 
a way to skip the patient in the PREV-8 measure on a case by case basis. If the patient is 
ranked in any other disease module, CARE measure, or PREV measure, the patient is only 
skipped in the PREV-8 module, not in all modules or patient care measures in which they are 
ranked. 

The No – Other CMS Approved Reason may be used  if the patient is not qualified for a 
reason other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The 
use of No – Other CMS Approved Reason for the PREV-8 measure is done on a case by case 
basis, and requires prior approval from CMS. 

The table below shows the available values and appropriate XML format for PREV-8 
Confirmation. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <pcpneumoshot-
confirmed>2</pcpneumoshot-
confirmed> 

Include required PREV-8 
measure elements to 
complete the patient’s data 
for PREV-8 

15 = No – Other CMS 
Approved Reason 

<pcpneumoshot-
confirmed>15</pcpneumoshot-
confirmed> 

Do not include PREV-8 
measure elements for this 
patient, patient is skipped in 
this measure 
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Available Values Sample XML Tag Other Parameters 

-1 = Update to NULL <pcpneumoshot-confirmed>-
1</pcpneumoshot-confirmed> 

None 

4.3.14.4.2. PREV-8 Vaccination Received 

Determine if the patient has ever received a pneumococcal vaccination. 

The table below shows the available values and appropriate XML format for Vaccination 
Received. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcpneumoshot>1</pcpneumoshot> None, measure is 
complete for this patient 

2 = Yes <pcpneumoshot>2</pcpneumoshot> None, measure is 
complete for this patient 

4 = No – Medical Reasons <pcpneumoshot>4</pcpneumoshot> None, measure is 
complete for this patient 

-1 = Update to NULL <pcpneumoshot>-1</pcpneumoshot> None 

4.3.14.5. PREV-9: Body Mass Index (BMI) Screening and Follow-Up 

Four values for abstraction are included in the PREV-9 measure: 

• Confirmation that the patient is qualified for the PREV-9 measure (BMI Confirmation) 

• Indicator that the patient had a Body Mass Index (BMI) Calculated if the patient is 
qualified (BMI Calculated) 

• Indicator if the patient’s most recent BMI is within normal parameters if the BMI was 
calculated (BMI Normal) 

• Indicator if follow-up plan is documented if the BMI is not within normal parameters (BMI 
Follow Up) 

All values may not be required for the PREV-9 measure to be marked complete. The PREV-9 
Confirmation must be provided. If the patient is qualified for the measure, the BMI Calculated 
value is required. 

If the BMI was calculated, the BMI Normal value must be provided. If the BMI was not 
calculated, the BMI Normal value should not be provided. 
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If the BMI is not normal, the Follow-Up Plan value must be provided. If the BMI is normal, the 
Follow-Up Plan value should not be provided. 

If the patient is not qualified for the measure, the patient is skipped in the measure and the 
measure data should not be provided. The PREV-9 measure will be marked as complete for the 
patient when all required fields have a value provided. 

4.3.14.5.1. PREV-9 Confirmation 

In addition to indicating the medical record was found for the patient, confirmation that the 
patient is qualified for the PREV-9 measure must be provided. PREV-9 Confirmation provides 
a way to skip the patient in the PREV-9 measure on a case by case basis. If the patient is 
ranked in any other disease module, CARE measure, or PREV measure, the patient is only 
skipped in the PREV-9 measure, not in all modules or patient care measures in which they are 
ranked. 

The No – Other CMS Approved Reason may be used  if the patient is not qualified for a 
reason other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The 
use of No – Other CMS Approved Reason for the PREV-9 measure is done on a case by case 
basis, and requires prior approval from CMS. 

The table below shows the available values and appropriate XML format for PREV-9 
Confirmation. 

4.3.14.5.2. PREV-9: BMI Calculated 

There are three determinations to be made with respect to calculating a BMI: 

• Determine if a BMI was Calculated 

• Determine if BMI is Normal 

• Determine if Follow-Up Plan is Documented  

Available Values Sample XML Tag Other Parameters 

2 = Yes <pcbmiscreen-
confirmed>2</pcbmiscreen-
confirmed> 

Include required PREV-9 
measure elements to 
complete the patient’s data 
for PREV-9 

15 = No – Other CMS 
Approved Reason 

<pcbmiscreen-
confirmed>15</pcbmiscreen-
confirmed> 

Do not include PREV-9 
measure elements for this 
patient, patient is skipped in 
this measure 

-1 = Update to NULL <pcbmiscreen-confirmed>-
1</pcbmiscreen-confirmed> 

None 
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4.3.14.5.2.1. Determine if a BMI was Calculated 

Determine if the patient had a Body Mass Index (BMI) calculated within the past six months or 
during the current visit. Use the most current visit. 

The table below shows the available values and appropriate XML format for BMI Calculated. 

4.3.14.5.2.2. Determine if BMI is Normal 

If the BMI was calculated, determine if the patient’s most recent BMI is within normal 
parameters. Normal parameters for BMI: 

• Age 65 and older BMI ≥ 23 and < 30 

• Age 18-64 BMI ≥ 18.5 and < 25 

The table below shows the available values and appropriate XML format for BMI Normal. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcbmicalculated>1</pcbmicalculated> Do not provide the BMI 
Normal value and 
Follow-Up Plan value, 
measure is complete for 
this patient 

2 = Yes <pcbmicalculated>2</pcbmicalculated> Provide the BMI Normal 
value and conditionally 
the  Follow-Up Plan 
value to complete the 
measure for this patient 

4 = No – Medical 
Reasons 

<pcbmicalculated>4</pcbmicalculated> Do not provide the BMI 
Normal value and 
Follow-Up Plan value, 
measure is complete for 
this patient 

5 = No – Patient 
Reasons 

<pcbmicalculated>5</pcbmicalculated> Do not provide the BMI 
Normal value and 
Follow-Up Plan value, 
measure is complete for 
this patient 

-1 = Update to NULL <pcbmicalculated>-
1</pcbmicalculated> 

None 
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Available Values Sample XML Tag Other Parameters 

1 = No <pcbminormal>1</pcbminormal> Provide the BMI 
Calculated value and 
Follow-Up Plan value to 
complete the measure for 
this patient 

2 = Yes <pcbminormal>2</pcbminormal> Provide the BMI 
Calculated value to 
complete the measure for 
this patient 

Do not provide the Follow-
Up Plan value 

-1 = Update to NULL <pcbminormal>-1</pcbminormal> None 

4.3.14.5.2.3. Determine if Follow-Up Plan is Documented 

If the BMI is outside of parameters, determine if a follow-up plan is documented. 

The table below shows the available values and appropriate XML format for PREV-9 Follow-Up 
Plan. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcbmiplan>1</pcbmiplan> Provide the BMI 
Calculated value and BMI 
Normal value to complete 
the measure for this 
patient 

2 = Yes <pcbmiplan>2</pcbmiplan> Provide the BMI 
Calculated value and BMI 
Normal value to complete 
the measure for this 
patient 

-1 = Update to NULL <pcbmiplan>-1</pcbmiplan> None 
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4.3.14.6. PREV-10: Tobacco Use: Screening and Cessation Intervention 

Three values for abstraction are included in the PREV-10 measure: 

• Confirmation that the patient is qualified for the PREV-10 measure (Tobacco Use 
Confirmation) 

• Indicator that the patient was screened for tobacco use if qualified (Patient Screened for 
Tobacco Use) 

• Indicator of cessation counseling if the patient has been identified as a tobacco user 
(Cessation Counseling Intervention) 

All values may not be required for the PREV-10 measure to be marked complete. The PREV-10 
Confirmation must be provided. If the patient is not qualified for the measure, the patient is 
skipped in the measure and the measure quality data should not be provided. 

If the patient is qualified for the measure, the Tobacco Use value is required. 

If the patient was screened for tobacco use and identified as a tobacco user, a value for 
Cessation Counseling must be provided. If the patient was screened for tobacco use and 
identified as a tobacco non-user or the patient was not screened for tobacco use, a value for 
Cessation Counseling should not be provided. 

 The PREV-10 measure will be marked as complete for the patient when all required fields have 
a value provided. 

4.3.14.6.1. PREV-10 Confirmation 

In addition to indicating the medical record was found for the patient, confirmation that the 
patient is qualified for the PREV-10 measure must be provided. PREV-10 Confirmation 
provides a way to skip the patient in the PREV-10 measure on a case by case basis. If the 
patient is ranked in any other disease module, CARE measure, or PREV measure, the patient is 
only skipped in the PREV-10 measure, not in all modules or patient care measures in which 
they are ranked. 

The No – Other CMS Approved Reason may be used  if the patient is not qualified for a 
reason other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The 
use of No – Other CMS Approved Reason for the PREV-10 is done on a case by case basis, 
and requires prior approval from CMS. 

The table below shows the available values and appropriate XML format for PREV-10 
Confirmation. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <pctobaccouse-
confirmed>2</pctobaccouse-
confirmed> 

Include required PREV-10 
measure elements to 
complete the patient’s data for 
PREV-10 
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Available Values Sample XML Tag Other Parameters 

15 = No – Other CMS 
Approved Reason 

<pctobaccouse-
confirmed>15</pctobaccouse-
confirmed> 

Do not include PREV-10 
measure elements for this 
patient, patient is skipped in 
this measure 

-1 = Update to NULL <pctobaccouse-confirmed>-
1</pctobaccouse-confirmed> 

None 

4.3.14.6.2. PREV-10 Tobacco Use 

Once tobacco use has been confirmed, the following must be indicated: 

• Determine if the Patient Screened for Tobacco Use 

• Determine Cessation Counseling Intervention 

4.3.14.6.2.1. Determine if the Patient was Screened for Tobacco Use 

Determine if the patient was screened for tobacco use at least once within 24 months AND 
identified as a tobacco user. 

The table below shows the available values and appropriate XML format for Tobacco Use. 

Available Values Sample XML Tag Other Parameters 

1 = No 

(Screened and a 
tobacco non-user) 

<pctobaccoscreen>1</pctobaccoscreen> Do not provide the 
Cessation 
Intervention value, 
measure is complete 
for this patient 

2 = Yes 

(Screened and a 
tobacco user) 

<pctobaccoscreen>2</pctobaccoscreen> Provide the Cessation 
Counseling value 

4 = No – Medical 
Reasons 

<pctobaccoscreen>4</pctobaccoscreen> Do not provide the 
Cessation 
Intervention value, 
measure is complete 
for this patient 
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Available Values Sample XML Tag Other Parameters 

14 = Not Screened <pctobaccoscreen>14</pctobaccoscreen> Do not provide the 
Cessation 
Intervention value, 
measure is complete 
for this patient 

-1 = Update to NULL <pctobaccoscreen>-1</pctobaccoscreen> None 

4.3.14.6.2.2. Determine Cessation Counseling Intervention 

Determine if tobacco cessation counseling intervention was received if the patient was identified 
as a tobacco user. If there is more than 1 patient query regarding tobacco use, use the most 
recent. 

The table below shows the available values and appropriate XML format for Cessation 
Counseling Intervention. 

4.3.14.7. PREV-11: Screening for High Blood Pressure and Follow-Up Documented 

Two values for abstraction are included in the PREV-11 individually sampled measure: 

• Confirmation that the patient is qualified for the PREV-11 measure (High Blood Pressure 
Confirmation) 

• Indicator if the patient was screened for high blood pressure if qualified (High Blood 
Pressure Screening) 

All values may not be required for the PREV-11 measure to be marked complete. Confirmation 
that the patient is qualified for the measure must be provided. If the patient is qualified for the 

Available Values Sample XML Tag Other Parameters 

1 = No <pctobaccocounsel>1</pctobaccocounsel> Provide the Tobacco 
Use value to complete 
the measure for this 
patient 

2 = Yes <pctobaccocounsel>2</pctobaccocounsel> Provide the Tobacco 
Use value to complete 
the measure for this 
patient 

-1 = Update to NULL <pctobaccocounsel>-
1</pctobaccocounsel> 

None 
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measure, all required values for the PREV-11 measure must be provided before the system can 
mark the patient as complete in the PREV-11 measure. If the patient is not qualified for the 
measure, the patient is skipped in the measure and the measure quality data should not be 
provided. 

4.3.14.7.1. PREV-11 Confirmation 

In addition to indicating the medical record was found for the patient, confirmation that the 
patient is qualified for the PREV-11 measure must be provided. PREV-11 Confirmation 
provides a way to skip the patient in the PREV-11 measure on a case by case basis. If the 
patient is ranked in any other disease module, CARE measure, or PREV measure, the patient is 
only skipped in the PREV-11 measure, not in all modules or patient care measures in which 
they are ranked. 

The No – Other CMS Approved Reason may be used if the patient is not qualified for a reason 
other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The use of No 
– Other CMS Approved Reason for the PREV-11 measure is done on a case by case basis, 
and requires prior approval from CMS. 

The table below shows the available values and appropriate XML format for PREV-11 
Confirmation. 

4.3.14.7.2. PREV-11 Blood Pressure Screening 

Determine if the patient was screened for high blood pressure and follow-up recommended as 
appropriate during the measurement period. Use most recent blood pressure. This measure 
only needs to be reported once per measurement period. 

Although recommended screening interval for a normal BP reading is every 2 years, to meet the 
intent of this measure, a BP screening must be performed once per measurement period. The 
intent of this measure is to screen patients for high blood pressure. Normal blood pressure 
follow-up is not recommended for patients with clinical or symptomatic hypotension. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <pcbloodpressure-
confirmed>2</pcbloodpressure-
confirmed> 

Include required PREV-11 
measure elements to 
complete the patient’s data 
for PREV-11 

15 = No – Other CMS 
Approved Reason 

<pcbloodpressure-
confirmed>15</pcbloodpressure-
confirmed> 

Do not include PREV-11 
measure elements for this 
patient, patient is skipped in 
this measure 

-1 = Update to NULL <pcbloodpressure-confirmed>-
1</pcbloodpressure-confirmed> 

None 
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The table below shows the available values and appropriate XML format for Blood Pressure 
Screening. 

4.3.14.8. PREV-12: Screening for Clinical Depression and Follow-Up Plan 

Four values for abstraction are included in the PREV-12 measure: 

• Confirmation that the patient is qualified for the PREV-12 measure (Depression 
Confirmation) 

• Indicator if the patient was screened for clinical depression if qualified (Patient Screened 
for Clinical Depression) 

• Indicator if the patient was positive for clinical depression if screened (Patient Positive 
for Clinical Depression) 

• Indicator if a follow-up plan is documented if the patient is positive for clinical depression 
(Follow-Up Plan for Clinical Depression Documented) 

All values may not be required for the PREV-12 measure to be marked complete. The PREV-12 
Confirmation must be provided. If the patient is not qualified for the measure, the patient is 
skipped in the measure and the measure quality data should not be provided. 

If the patient is qualified for the PREV-12 measure, the Clinical Depression Screening value 
must be provided. 

If the patient was screened for Clinical Depression, a value for Positive for Clinical 
Depression must be provided. If the patient was not screened for clinical depression, the 
Positive for Clinical Depression value should not be provided. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcbloodpressure>1</pcbloodpressure> None, measure is complete 
for this patient 

2 = Yes <pcbloodpressure>2</pcbloodpressure> None, measure is complete 
for this patient 

4 = No – Medical 
Reasons 

<pcbloodpressure>4</pcbloodpressure> None, measure is complete 
for this patient 

5 = No – Patient 
Reasons 

<pcbloodpressure>5</pcbloodpressure> None, measure is complete 
for this patient 

-1 = Update to NULL <pcbloodpressure>-1</pcbloodpressure> None 
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If the patient is positive for clinical depression, a value for Follow-Up Plan must be provided. If 
patient is not positive for clinical depression, a value for Follow-Up Plan should not be 
provided. 

4.3.14.8.1. PREV-12 Confirmation 

In addition to indicating the medical record was found for the patient, confirmation that the 
patient is qualified for the PREV-12 measure must be provided. PREV-12 Confirmation 
provides a way to skip the patient in the PREV-12 measure on a case by case basis. If the 
patient is ranked in any other disease module, CARE measure, PREV measure, the patient is 
only skipped in the PREV-12 module, not in all modules or patient care measures in which they 
are ranked. 

The No – Other CMS Approved Reason may be used  if the patient is not qualified for a 
reason other than In Hospice, Moved out of Country, Deceased, or HMO Enrollment. The 
use of No – Other CMS Approved Reason for the PREV-12 measure is done on a case by 
case basis, and requires prior approval from CMS. 

The table below shows the available values and appropriate XML format for PREV-12 
Confirmation. 

4.3.14.8.2. Depression Screening 

Once it is confirmed that the patient has been diagnosed as Clinically Depressed, the following 
applies: 

• Determine if Patient was Screened for Clinical Depression 

• Determine if Patient was Positive for Clinical Depression 

• Determine if Follow-Up Plan is Documented 

Available Values Sample XML Tag Other Parameters 

2 = Yes <pcdepression-
confirmed>2</pcdepression-
confirmed> 

Include required PREV-12 
measure elements to 
complete the patient’s data 
for PREV-12 

15 = No – Other CMS 
Approved Reason 

<pcdepression-
confirmed>15</pcdepression-
confirmed> 

Do not include PREV-12 
measure elements for this 
patient, patient is skipped in 
this measure 

-1 = Update to NULL <pcdepression-
confirmed>2</pcdepression-
confirmed> 

None 
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4.3.14.8.2.1. Determine if the Patient was Screened for Clinical Depression 

Determine if the patient was screened for clinical depression using an age appropriate 
standardized tool during the measurement period. 

The table below shows the available values and appropriate XML format for Clinical 
Depression Screening. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcdepression>1</pcdepression> Do not provide the Positive 
for Clinical Depression 
value and Follow-Up Plan 
value, measure is complete 
for this patient 

2 = Yes <pcdepression>2</pcdepression> Provide the Positive for 
Clinical Depression and 
conditionally provide the 
Follow-Up Plan value to 
complete the measure for 
this patient 

4 = No – Medical 
Reasons 

<pcdepression>4</pcdepression> Do not provide the Positive 
for Clinical Depression 
value and Follow-Up Plan 
value, measure is complete 
for this patient 

5 = No – Patient Reasons <pcdepression>5</pcdepression> Do not provide the Positive 
for Clinical Depression 
value and Follow-Up Plan 
value, measure is complete 
for this patient 

-1 = Update to NULL <pcdepression>-1</pcdepression> None 
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4.3.14.8.2.2. Determine if the Patient was Positive for Clinical Depression 

If the patient was screened, determine if the screen was Positive for Clinical Depression 
during the measurement period. 

The table below shows the available values and appropriate XML format for Positive for 
Clinical Depression. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcdepression-
positive>1</pcdepression-
positive> 

Provide the Clinical 
Depression Screening 
value 

Do not provide the Follow-
Up Plan value, measure is 
complete for this patient 

2 = Yes <pcdepression-
positive>2</pcdepression-
positive> 

Provide the Clinical 
Depression Screening 
value and Follow-Up Plan 
value to complete the 
measure for this patient 

-1 = Update to NULL <pcdepression-positive>-
1</pcdepression-positive> 

None 

4.3.14.8.2.3. Determine if Follow-Up Plan is Documented 

If the patient had a positive screen for clinical depression, determine if a follow-up plan for 
depression was documented during the measurement period. 

The table below shows the available values and appropriate XML format for depression Follow-
Up Plan. 

Available Values Sample XML Tag Other Parameters 

1 = No <pcdepression-
plan>1</pcdepression-plan> 

Provide the  Clinical 
Depression Screening value 
and  Positive for Clinical 
Depression value to 
complete the measure for this 
patient 
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Available Values Sample XML Tag Other Parameters 

2 = Yes <pcdepression-
plan>2</pcdepression-plan> 

Provide the  Clinical 
Depression Screening value 
and  Positive for Clinical 
Depression value to 
complete the measure for this 
patient 

-1 = Update to NULL <pcdepression-plan>-
1</pcdepression-plan> 

None 

4.3.14.9. PREV Comments 

The Optional Comments for the PREV patient care measures can be used to provide 
additional information for the patient related to any PREV measure in which the patient is 
ranked. If a patient is ranked in multiple PREV measures and multiple files are used to upload 
individual PREV measure data, the comments for the patient may be included in any file. It 
should be noted that the comments should be the same for any PREV measure in which the 
patient is ranked. If the comments are different, the comments in the last uploaded file will 
overwrite any previous comments. 

The table below shows the available values and appropriate XML format for the PREV Optional 
Comments. 

4.3.15. Patients XML Error Messages 
If there are errors in the format of the Patients XML file to be uploaded, the error messages and 
the line on which the error occurs will be provided. If the file contains XML elements that are not 
included in the specification, the error displayed will indicate an invalid XML format. If the file 
format is not valid, the first error message will be logged and processing will not 
continue.  Examples of invalid file formats include an incorrect XML declaration,  incorrect 
header, a missing required tag, a tag that is not one of the tags specified in the XML 
Specification, or any text that is not one of the valid tags. 

The table below shows the possible errors and associated condition causing the error for the 
XML validation. 

Available Values Sample XML Tag Other Parameters 

Text up to 250 characters <prev-comments>Text for 
comment</prev-comments> 

None 

-1 = Update to NULL <prev-comments>-1</prev-
comments> 

None 
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Message 
Number XML Element Condition Message Description 

3300 N/A An problem exists in the system. The 
XML file cannot be processed until 
the problem is resolved. 

System Error. Please 
contact the helpdesk. 

3301 XML Declaration The XML Declaration does not 
exactly match XML Specifications. 

Caused by including the Byte Order 
Mark (BOM) in the encoding when 
saving the file. 

Invalid XML header. 
Expected <?xml 
version=”1.0” 
encoding=”UTF-8”?> 

3302 N/A Invalid or mismatched Data Element 
Tag/Attribute, missing parent tag for 
sub-tag, invalid or missing elements 
in the <submission> tag, any tag that 
does not exist in the XML spec, or 
including any characters that are not 
in the specification for a tag or 
allowable data. 

Note: Additional information may be 
provided in the error message 
indicating the invalid tag. An invalid 
tag may be indicated for a valid tag 
missing the parent tag. 
If an invalid tag is found in the file, 
processing will not continue and 
additional errors will not be logged. 

Invalid XML File. 

3303 Any XML element 
indicated as 
required in the 
XML Specification 

A required XML element tag is 
missing. When the error message is 
displayed, the error message will 
display the required XML tag in the 
[<tag>] portion of the error message. 

If a missing required tag is detected 
in the file, processing will not 
continue and additional errors will not 
be logged. 

 [<tag>] tag is required. 
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Message 
Number XML Element Condition Message Description 

3304 Any XML Element 
containing 
validated data 

The data in the tag is not one of the 
allowable values for the XML 
Element. The XML Specification 
indicates the allowable values for 
each of the tags. When the error 
message is displayed, the error 
message will display the XML tag 
containing the invalid value in the 
[<tag>] portion of the error message. 

The value in [<tag>] is not 
an allowable value for this 
tag. 

3305 <group-tin> ACO GPROs: The Primary Taxpayer 
Identification Number in the file and 
the Primary Taxpayer Identification 
Number to which the user is 
associated do not match. 

PQRS GPROs: The Taxpayer 
Identification Number in the file and 
the Taxpayer Identification Number 
to which the user is associated do 
not match. 

When the user’s IACS account is 
associated to multiple Primary 
Taxpayer Identification Numbers or 
Taxpayer Identification Numbers, the 
number used to log in must match 
the number in the file. 

Note that for this error message a 
line number will not be displayed. 

When the error message is 
displayed, the "[TIN]" will be replaced 
with the TIN in the file. 

Could not process the file 
because the TIN- [TIN] in 
the XML file does not 
match the user’s TIN. 
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Message 
Number XML Element Condition Message Description 

3306 <medicare-id> Medicare ID specified in the XML file 
does not exist in the database. All the 
patients selected for the sample are 
loaded into the database. The 
Medicare ID specified for a patient in 
the file must be the Medicare ID for 
one of the patients selected for the 
sample. 

Note that for this error message a 
line number will not be displayed. 

When the error message is 
displayed, the "[MEDICARE ID]" will 
be replaced with the Medicare ID in 
the file that is not in the database. 

Medicare ID - [MEDICARE 
ID] does not exist. 

3307 <medicare-id> Medicare ID is duplicated in the XML 
file. All data for a single patient must 
be contained between the opening 
<patient> and closing </patient> 
tags. The Medicare ID is the identifier 
for the patient, and may only be used 
once in a file. 

Medicare ID can only be 
specified once per patient. 
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Message 
Number XML Element Condition Message Description 

3308 <provider-npi> 

OR 

<provider-npi-
two> 

OR 

<provider-npi-
three> 

The Provider NPI must exist in the 
database before it may be used in 
the XML file to associate a provider 
to a patient. 

Provider NPIs are loaded into the 
database when the patient sample is 
loaded. Additional Provider NPIs may 
be entered into the Web Interface, 
which will store the Provider NPI in 
the database. 

Note that for this error message a 
line number will not be displayed. 

When the error message is 
displayed, the "[NPI]"will be replaced 
with the NPI in the file that does not 
exist in the database. 

When the error message is 
displayed, the "[MEDICARE ID]" will 
be replaced with the Medicare ID in 
the file for the patient where the NPI 
does not exist. 

Provider NPI - [NPI] is not 
an existing NPI for 
Medicare ID - [MEDICARE 
ID]. 

3309 Any XML Element 
containing a 
validated date 

Date is not in a valid format: 

Valid Format = MM/DD/YYYY. 

Month and Day may be one (1) or 
two (2) digits, but year must be four 
(4) digits. 

Month cannot be 0 or 00 and cannot 
be greater than 12. 

Date cannot be 0 or 00 and cannot 
be greater than 31. 

Date cannot exceed limit for month. 

All dates must be for the current 
program year (2013). 

Date is not an allowable 
value or the format is 
incorrect. 
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Message 
Number XML Element Condition Message Description 

3310 <clinic-id> The Clinic ID must exist in the 
database before it may be used in 
the XML file to associate a clinic to a 
patient. 

Clinic IDs are loaded into the 
database when the patient sample is 
loaded. Additional Clinic Ids may be 
entered into the Web Interface, which 
will store the Clinic ID in the 
database. 

Note that for this error message a 
line number will not be displayed. 

When the error message is 
displayed, the "[CLINIC ID]"will be 
replaced with the Clinic ID in the file 
that does not exist in the database. 

When the error message is 
displayed, the "[MEDICARE ID]" will 
be replaced with the Medicare ID in 
the file for the patient where the 
Clinic ID does not exist. 

Clinic ID - [CLINIC ID] is 
not a valid ID for Medicare 
ID - [MEDICARE ID]. 

  

4.3.16. Patient Discharge XML 
The Patient Discharge XML can be used to export currently stored data for the patients ranked 
in the CARE-1 measure or to update the patient data for CARE-1 by uploading an XML file. The 
values for CARE Medical Record Found are applied to both the CARE-1 measure and the 
CARE-2 measure. This allows for the ability to confirm the Medical Record Found for CARE-1 
in either the Patients XML or the Patient Discharge XML and provides the ability to use an Excel 
spreadsheet to view and update the Patient Discharge dates and associated values. 

The XML file generated by the Web Interface will only include the patients ranked in CARE-1. If 
a patient is ranked in the measure, but data has not been stored in the database for the 
associated XML elements, the elements will be included, but the element will be an empty tag. 
The discharge dates are pre-populated during the sampling. Discharge dates cannot be 
modified, added, or deleted during the submission period. 

Appendix B – XML Elements for Patient Discharge XML File, lists all possible XML elements for 
the Patient Discharge file in the required order. 
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4.3.16.1. XML Declaration and Submission Header 

The XML Declaration must meet the following three requirements or it will be rejected as an 
invalid file: 

1. The XML Declaration must be on the first line 

2. The XML Declaration may not contain any other XML elements 

3. The XML Declaration must be an exact match for the valid value specified Appendix B – 
XML Elements for Patient Discharge XML File 

A Submission Header is required at the beginning of each Patient Discharge XML file. The 
opening tag for the Submission Header should be the first XML element in the file, and the 
closing tag for the submission header should be the last XML element in the file. The 
submission opening element <submission> and submission closing element </submission> may 
occur once in the file, and all submission data must be between the opening and closing 
elements. The data in the opening submission element should match the text exactly. 

4.3.16.2. File Audit Data 

The File Audit Data XML elements are sub-elements of the <submission> element. The 
information in the File Audit Data will be provided when the file is exported for information only. 
The information may be included in the file to be uploaded if the creator desires the information 
for tracking purposes, but the data is not required. Any data provided in the Submission Period 
Dates will only be validated for format, it will not be stored in the database. 

4.3.16.3. Submission Period Dates 

The Submission Period Dates XML elements are sub-elements of the <submission> element. 
The information in the Submission Period Dates will be provided when the file is exported for 
information only. The information may be included in the file to be uploaded if the creator 
desires the information for tracking purposes, but the data is not required. Any data provided in 
the Submission Period Dates will only be validated for format, it will not be stored in the 
database. 

4.3.16.4. Group Identification 

The Group Identification provides the type of submission data and the Primary Taxpayer 
Identification Number for ACO GPROs or the Taxpayer Identification Number for PQRS 
GPROs. The Group Identification XML elements are sub elements of the <submission> 
element. All data for the patients in the group must be included between the opening <web-
interface> element and the closing </web-interface> element. For ACO GPROs, the Primary 
Taxpayer Identification Number in the file must match the Primary Taxpayer Identification 
Number associated to the IACS ID of the user submitting the file. For PQRS GPROs, the 
Taxpayer Identification Number in the file must match the Taxpayer Identification Number 
associated to the IACS ID of the user submitting the file. 

The opening <patient> element and the closing </patient> element are used for each patient in 
the file. Data for a patient must be between an opening <patient> and closing </patient> 



XML Specifications 

GPRO-ACO XML Specification v2.0 81 PQRS PY2013 12/20/2013 

element, but the <patient> element and the sub-elements of the patient element may be 
repeated as often as necessary for a patient with multiple discharge dates. 

The table below shows the appropriate XML format with a sample TIN for the Group 
Identification TIN. 

Available Values Sample XML Tag Other Parameters 

Character <group-
tin>0000000000</group-tin> 

Include XML elements for 
patient data 

4.3.16.5. Patient Identification 

The opening <patient> element and the closing </patient> element are used for each patient in 
the file. Data for a patient must be between an opening <patient> and closing </patient> 
element, but the <patient> elements may be repeated as often as necessary for a patient with 
multiple discharges. The Medicare ID is the unique identifier for the patient and as such is the 
primary key. 

4.3.16.6. CARE-1 Medication Reconciliation 

The CARE-1 measure includes elements for: 

• CARE-1 Rank 

• CARE-1 Medical Record Found 

• CARE-1: Medication Reconciliation 

• CARE-1 Comments 

4.3.16.6.1. CARE-1 Medical Record Found 

The Medical Record Found contains three values: 

• Medical Record Found 

• Reason a patient is not qualified for the sample 

• Date the patient became ineligible for the sample 

If the medical record can be found for the patient, values for the CARE-1 measure must be 
provided for the patient to be considered complete in the associated CARE-1 measure. 

If the patient’s medical record cannot be found, or the patient is not qualified for the sample, the 
values for the CARE measures should not be provided. 

If the patient is ranked in other disease modules or patient care measures uploaded in the 
Patients XML file, the medical record found value should be the same for the patient in both the 
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Patients XML and the Patient Discharge XML. If the values are different, the value in the last 
uploaded file will overwrite any previous values. 

If the patient is not qualified for the sample, the reason they are ineligible and the date they 
became ineligible must be provided in order for the patient to be considered skipped in the 
CARE measures. 

4.3.16.6.1.1. Confirm Medical Record Found 

Determine if you are able to find the patient’s medical record. 

The table below shows the available values and appropriate XML format for the Medical 
Record Found. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <medical-record-
found>2</medical-record-
found> 

Include required confirmation and 
required measure elements for all 
disease modules, CARE measures, 
or PREV measures in which the 
patient is ranked to complete the 
patient’s data 

Do not include Medical Record 
Found Reason value and Medical 
Record Found  Date value 

3 = Medical Record 
Not Found 

<medical-record-
found>3</medical-record-
found> 

Do not include Medical Record 
Found Reason value and Medical 
Record Found Date value or 
measure elements for this patient 

Patient is skipped in all disease 
modules, CARE measures, or PREV 
measures in which the patient is 
ranked 

9 = Not Qualified for 
Sample 

<medical-record-
found>9</medical-record-
found> 

Include Medical Record Found 
Reason value and Medical Record 
Found Date value 

Do not include measure elements for 
this patient 

Patient is skipped in all disease 
modules, CARE measures, or PREV 
measures in which the patient is 
ranked 
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Available Values Sample XML Tag Other Parameters 

-1 = Update to NULL <medical-record-found>-
1</medical-record-found> 

None 

4.3.16.6.1.2. Provide the Reason the Patient is Not Qualified for Sample 

If the Medical Record Found value is set to Not Qualified for Sample, the reason and date 
must be provided for the patient to be marked as skipped. 

The table below shows the available values and appropriate XML format for the Not Qualified 
for Sample reasons. 

Available Values Sample XML Tag Other Parameters 

10 = In Hospice <medical-not-qualified-
reason>10</medical-not-
qualified-reason> 

Include the Medical Record Found 
value and Medical Record Found 
Date value 

Patient is skipped in all disease 
modules, CARE measures, or PREV 
measures in which the patient is 
ranked 

11 = Moved out of 
Country 

<medical-not-qualified-
reason>11</medical-not-
qualified-reason> 

Include the Medical Record Found 
value and Medical Record Found 
Date value 

Patient is skipped in all disease 
modules, CARE measures, or PREV 
measures in which the patient is 
ranked 

12 = Deceased <medical-not-qualified-
reason>12</medical-not-
qualified-reason> 

Include the Medical Record Found 
value and Medical Record Found 
Date value 

Patient is skipped in all disease 
modules, CARE measures, or PREV 
measures in which the patient is 
ranked 
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Available Values Sample XML Tag Other Parameters 

16 = HMO 
Enrollment 

<medical-not-qualified-
reason>16</medical-not-
qualified-reason> 

Include the Medical Record Found 
value and Medical Record Found 
Date value 

Patient is skipped in all disease 
modules, CARE measures, or PREV 
measures in which the patient is 
ranked 

-1 = Update to NULL <medical-not-qualified-
reason>-1</medical-not-
qualified-reason> 

None 

4.3.16.6.1.3. Provide the Date the Patient Became Ineligible for the Sample 

If the patient is not qualified for the sample and the reason is in hospice, moved out of the 
country, deceased, or HMO Enrollment, the date must be provided for the patient to be marked 
as Skipped. Enter the date in MM/DD/YYYY format the patient became ineligible for the sample 
during the measurement period (if date unknown enter 12/31/2013). 

The table below shows the available values and appropriate XML format for the Not Qualified 
for Sample date. 

Available Values Sample XML Tag Other Parameters 

Valid date between 
01/01/2013 and 12/31/2013 

<medical-not-qualified-
date>12/01/2013</medical-
not-qualified-date> 

Include the Medical Record 
Found value and Medical 
Record Found Reason value 

Patient is skipped in all 
 disease modules, CARE 
measures, or PREV measures 
 in which the patient is ranked 

-1 = Update to NULL <medical-not-qualified-date>-
1</medical-not-qualified-date> 

None 

4.3.16.6.2. CARE-1 Rank 

The CARE-1 Rank provides the patient’s assigned order in the CARE-1 measure, and is 
provided in the exported files for information only. The rank cannot be changed from the value 
assigned to the patient during the patient sampling. If the patient has not been selected for the 
CARE-1 measure, the associated CARE-1 Rank will not be included in the Patient Discharge 
XML files exported from the Web Interface. 
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The patient’s CARE-1 Rank is not required in the XML files to be uploaded. If the CARE-1 
Rank is included in the file, the XML element and associated data will be ignored. 

The table below shows the available values and appropriate XML format for the CARE-1 Rank. 

Available Values Sample XML Tag Other Parameters 

1 – 616 <caremedcon-rank>27<caremedcon-
rank> 

Ignored on Upload, provided 
for information on Export 

4.3.16.6.3. CARE-1 Confirmation 

CARE-1 Confirmation provides a way to skip a patient in the CARE-1 measure on a case by 
case basis. If the patient is not qualified for CARE-1 for a reason other than In Hospice, Moved 
out of Country, Deceased, or HMO Enrollment, the No – Other CMS Approved Reason may 
be used with prior CMS approval. If the patient is ranked in any other disease module, CARE 
measure, or PREV measure, the patient is only skipped in the CARE-1 module, not all in all 
modules or patient care measures in which they are ranked. 

When Medical Record Found is set to Yes, the confirmation for CARE-1 will also be set to Yes 
when the XML file is processed. Therefore, the CARE-1 Confirmation value only needs to be 
provided if the Medical Record Found value has not been provided, the No – Other CMS 
Approved Reason value is being provided, or a previously entered value is being updated. 

Available Values Sample XML Tag Other Parameters 

2 = Yes <caremedcon-
confirmed>2<caremedcon-
confirmed> 

Include required CARE-1 
measure elements to 
complete the patient’s data 
for CARE-1 

15 = No – Other CMA 
Approved Reason 

<caremedcon-
confirmed>15<caremedcon-
confirmed> 

Do not include CARE-1 
measure elements for this 
patient, patient is skipped in 
this measure 

-1 = Update to NULL <caremedcon-confirmed>-
1<caremedcon-confirmed> 

None 

4.3.16.6.4. Optional Comments for the CARE-1 and CARE-2 Measures 

The Optional Comments for the CARE measures can be used to provide additional information 
for the patient related to CARE-1 and CARE-2. Optional Comments for CARE-1 can also be 
provided in the Patient file. It should be noted that the comments should be the same for a 
patient ranked in both CARE-1 and CARE-2. If the comments are different, the comments in the 
last uploaded file will overwrite any previous comments. 
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The table below the available values and appropriate XML format for the CARE Optional 
Comments. 

4.3.16.6.5. CARE-1: Medication Reconciliation 

Four types of information are required to complete the CARE-1 measure: 

• Discharge Date 

• Confirmation that the patient was discharged from an inpatient facility 

• Confirmation that the patient had an office visit within 30 days of the inpatient facility 
discharge 

• Confirmation that the discharge medications were reconciled with the current medication 
list 

All information may not be required for the CARE-1 measure to be marked complete. A value for 
confirmation that the patient was discharged from an inpatient facility on the pre-populated date 
must be provided for all discharge dates. If the discharge cannot be confirmed, the remaining 
values for that discharge are not required. If the discharge is confirmed, a value for the office 
visit must be provided. If the patient had an office visit within 30 days of the discharge, a value 
for medication reconciliation must be provided. 

4.3.16.6.5.1. Discharge Date 

The Discharge Date will be pre-populated from claims during the sampling for CARE-1. 
Discharge Date cannot be modified, added or deleted. If a discharge date in the XML file does 
not exist for the patient, the XML file will pass format validation, but the measure data for that 
date will not be updated. 

The Discharge Date element may be repeated for each discharge associated to a patient, but 
only one set of discharge date elements for a patient may be between the opening <patient> 
element and the closing </patient> element. 

Note: The valid discharge dates are 01/01/2013 through 10/31/2013. Since the dates are pre-
populated with dates falling within the range, the XML validation checks for a valid date in 2013, 
without limiting the date range. However, if an date outside the date range is provided, the XML 
processing will reject the date and the associated tags because the date will not exist. 

Available Values Sample XML Tag Other Parameters 

Text up to 250 characters <care-comments>Text for 
comment</care-comments> 

None 

-1 = Update to NULL <care-comments>-1</care-
comments> 

None 
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The table below shows the available values and appropriate XML format for the Discharge 
Date. 

4.3.16.6.5.2. Determine if the Patient was Discharged from an Inpatient Facility 

Determine if the patient was discharged from an inpatient facility during the measurement 
period. Inpatient discharges will be pre-populated from claims. This measure is to be reported 
each time a patient was discharged from an inpatient facility and had an office visit within 30 
days of discharge during the measurement period. 

The table below shows the available values and appropriate XML format for the Discharge 
Confirmation. 

Available Values Sample XML Tag Other Parameters 

1 = No <discharge-
confirmation>1</discharge-
confirmation> 

Provide the Discharge 
Date value 

Do not provide the Office 
Visit value and Medication 
Reconciliation value, this 
discharge is complete 

2 = Yes <discharge-
confirmation>2</discharge-
confirmation> 

Provide the Discharge 
Date value and Office Visit 
value, and conditionally, 
the Medication 
Reconciliation value to 
complete this discharge 

-1 = Update to NULL <discharge-confirmation>-
1</discharge-confirmation> 

None 

4.3.16.6.5.3. Determine if Patient had Office Visit Within 30 Days 

Determine if the patient was seen within 30 days following an inpatient facility discharge. 

Available Values Sample XML Tag Other Parameters 

Valid date between 
01/01/2013 and 
10/31/2013 in format 
MM/DD/YYYY 

See note above on date 
range validation 

<discharge-
date>02/20/2013</discharge-date> 

  

Provide the Discharge 
Confirmation value and 
conditionally the Office 
Visit value and Medication 
Reconciliation value 
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The table below shows the available values and appropriate XML format for the office visit. 

Available Values Sample XML Tag Other Parameters 

1 = No <office-visit>1</office-visit> Provide the Discharge Date 
value 

Do not provide the 
Medication Reconciliation 
value, this discharge is 
complete 

2 = Yes <office-visit>2</office-visit> Provide the Discharge Date 
value 

Provide the Medication 
Reconciliation value to 
complete this discharge 

-1 = Update to NULL <office-visit>-1</office-visit> None 

4.3.16.6.5.4. Determine Medication Reconciliation 

Determine if discharge medications were reconciled with the current medication list in the 
outpatient medical record within 30 days following this inpatient facility discharge 

The table below shows the available values and appropriate XML format for Medication 
Reconciliation. 

Available Values Sample XML Tag Other Parameters 

1 = No <medication-
reconciliation>1</medication-
reconciliation> 

Provide the Discharge 
Date value and Office Visit 
value to complete this 
discharge 

2 = Yes <medication-
reconciliation>2</medication-
reconciliation> 

Provide the Discharge 
Date value and Office Visit 
value to complete this 
discharge 

-1 = Update to NULL <medication-reconciliation>-
1</medication-reconciliation> 

None 
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4.3.16.7. Patient Discharge XML Errors 

If there are errors in the format of the Patient Discharge XML file to be uploaded, the error 
messages and the line on which the error occurs will be provided. If the file contains XML 
elements that are not included in the specification, the error displayed will indicate an invalid 
XML format. If the file format is not valid, the first error message will be logged and processing 
will not continue.  Examples of invalid file formats include an incorrect XML 
declaration,  incorrect header, a missing required tag, a tag that is not one of the tags specified 
in the XML Specification, or any text that is not one of the valid tags. 

The table below shows the possible errors and associated condition causing the error for the 
XML validation. 

Message 
Number XML Element Condition Message Description 

3300 N/A An problem exists in the system. The 
XML file cannot be processed until the 
problem is resolved. 

System Error. Please 
contact the helpdesk. 

3301 XML Declaration The XML Declaration does not exactly 
match XML Specifications. 

Including the Byte Order Mark (BOM) in 
the encoding when saving the file. 

Invalid XML header. 
Expected <?xml 
version=”1.0” 
encoding=”UTF-8”?> 

3302 N/A Invalid or mismatched Data Element 
Tag/Attribute, missing parent tag for sub-
tag, invalid or missing elements in the 
<submission> tag, any tag that does not 
exist in the XML spec, or including any 
characters that are not in the specification 
for a tag or allowable data. 

Note: Additional information may be 
provided in the error message indicating 
the invalid tag. An invalid tag may be 
indicated for a valid tag missing the 
parent tag. 

If an invalid tag is found in the file, 
processing will not continue and 
additional errors will not be logged. 

Invalid XML File. 
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Message 
Number XML Element Condition Message Description 

3303 Any XML element 
indicated as 
required in the 
XML Specification 

A required XML element tag is missing. 
When the error message is displayed, the 
error message will display the required 
XML tag in the [<tag>] portion of the error 
message. 

If a missing required tag is detected in the 
file, processing will not continue and 
additional errors will not be logged. 

 [<tag>] tag is 
required. 

3304 Any XML Element, 
except a date 
element, 
containing 
validated data 

The data in the tag is not one of the 
allowable values for the XML Element. 
The XML Specification indicates the 
allowable values for each of the tags. 
When the error message is displayed, the 
error message will display the XML tag 
containing the invalid value in the [<tag>] 
portion of the error message. 

The value in [<tag>] is 
not an allowable value 
for this tag. 

3305 <group-tin> ACO GPROs: The Primary Taxpayer 
Identification Number in the file and the 
Primary Taxpayer Identification Number 
to which the user is associated do not 
match. 

PQRS GPROs: The Taxpayer 
Identification Number in the file and the 
Taxpayer Identification Number to which 
the user is associated do not match. 

When the user’s IACS account is 
associated to multiple Primary Taxpayer 
Identification Numbers or Taxpayer 
Identification Numbers, the number used 
to log in must match the number in the 
file. 

Note that for this error message a line 
number will not be displayed. 

When the error message is displayed, the 
"[TIN]" will be replaced with the TIN in the 
file. 

Could not process the 
file because the TIN - 
[TIN] in the XML file 
does not match the 
user’s TIN. 
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Message 
Number XML Element Condition Message Description 

3306 <medicare-id> Medicare ID specified in the XML file 
does not exist in the database. All the 
patients selected for the sample are 
loaded into the database. The Medicare 
ID specified for a patient in the file must 
be the Medicare ID for one of the patients 
selected for the sample. 

Note that for this error message a line 
number will not be displayed. 

When the error message is displayed, the 
"[MEDICARE ID]" will be replaced with 
the Medicare ID that is not in the 
database. 

Medicare ID - 
[MEDICARE ID] does 
not exist. 

  

3309 Any XML Element 
containing a 
validated date 

Date is not in a valid format: 

Valid Format = MM/DD/YYYY. 

Month and Day may be one (1) or two (2) 
digits, but year must be four (4) digits. 

Month cannot be 0 or 00 and cannot be 
greater than 12. 

Date cannot be 0 or 00 and cannot be 
greater than 31. 

Date cannot exceed limit for month. 

When validating the format of the data, 
the dates must be for the current program 
year (2013). However, when processing 
the XML file the Discharge Dates are 
limited to the pre-populated dates which 
are between January 1, 2013 and 
October 31, 2013. 

Date is not an 
allowable value or the 
format is incorrect. 
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Message 
Number XML Element Condition Message Description 

3311 <discharge-date> The Discharge Date for the patient must 
exist in the database. The Discharge 
Dates are loaded into the database when 
the patient sample is loaded. The pre-
populated dates are the only dates which 
may be used for a patient. 

Note that for this error message a line 
number will not be displayed. 

When the error message is displayed, the 
"[DATE]" will be replaced with the date in 
the file that is not in the database. 

When the error message is displayed, the 
"[MEDICARE ID]" will be replaced with 
the Medicare ID in the file for the patient 
where the Discharge Date does not exist. 

Discharge Date - 
[DATE] is not valid for 
the patient - 
[MEDICARE ID]. 

4.4. Patient Ranking XML 
The Patient Ranking XML file is used to export the list of patients for a group. The information in 
the file cannot be updated by uploading a file. When exporting the data, the Web Interface 
allows the selection of one or more disease modules or patient care measures on the Export 
Data page. 

The XML file generated by the Web Interface will only include the patients ranked in the 
selected disease modules or patient care measures. An option is provided to allow the patient 
data to be exported in one of two ways. 

1. Export only selected module or patient care measure data for the patient. If a patient is 
ranked in multiple modules or patient care measures, only the XML rank elements 
associated with the selected modules or patient care measures will be included for that 
patient. If a patient is ranked in a module or patient care measure that has been selected 
and is also ranked in a module or patient care measure that has not been selected, the 
rank for the unselected module or measure will not be included in the file. This option 
prevents duplicate data for a patient when data is exported one module or patient care 
measure at a time. 

2. Export all module or patient care measure ranks for the patient. If a patient is ranked in 
multiple modules or patient care measures, all XML rank elements for any module or 
patient care measure in which the patient is ranked will be included for the patient. If a 
patient is ranked in a module or patient care measure that has been selected and is also 
ranked in a module or patient care measure that has not been selected, the rank for the 
unselected modules or patient care  measures will also be included in the file. This 
option allows exporting all ranks for all modules or patient care measures for a patient 
when rank is exported one module or patient care measure at a time. 
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The audit data is provided to allow tracking of when the file was exported. 

The opening <patient> element and closing </patient> element are repeated for each patient. 
The demographics data will be included for each patient, and the module or patient care 
measure rank XML element will be included for each selected module or patient care measure 
in which the patient is ranked. 

The table below shows all the Patient Ranking XML elements and associated data. 

XML Element Description Data 
Type 

Field 
Size Valid Values 

N/A XML Declaration String 38 <?xml version=”1.0” 
encoding=”UTF-8”?> 

<export> Header String 200 <export version=”3.0” 
type=”WEB-INTERFACE-
PATIENT-RANKING” 
xmlns:xsi=”http://www.w3.org/20
01/XMLSchema-instance” 
xmlns:noNamespaceSchemaLo
cation=”WEB-INTERFACE-
PATIENT-RANKING.xsd” 
xmlns=”gov/cms/pqrs/patientRa
nking/v1”> 

<file-audit-data> Opening element for file 
audit data 

N/A N/A N/A 

<file-number> Identifier for the file String 20 Number 

<create-date> Date the file was created String 10 MM/DD/YYYY 

<create-time> Time the file was created Time 5 HH:MM (Military format with 
colon) 

<create-by> IACS ID and “-WebUI” String 50 Character 

<version> Version of the file being 
exported 

String 20 Character 

</file-audit-data> Closing element for file audit 
data 

N/A N/A N/A 
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XML Element Description Data 
Type 

Field 
Size Valid Values 

<export-period-
from-date> 

Start of the Submission 
Period for which data is 
being exported 

String 10 MM/DD/YYYY 

  

<export-period-to-
date> 

End of the Submission 
Period for which data is 
being exported 

String 10 MM/DD/YYYY 

  

<web-interface> Opening element for group 
data 

N/A N/A N/A 

<group-tin> ACO GPROs: Primary 
Taxpayer Identification 
Number 

PQRS GPRO: Taxpayer 
Identification Number 

String 9 Number 

<patient> Opening tag for the patient 
data, repeats for each 
patient in the file 

N/A N/A N/A 

<medicare-id> Medicare HIC number – 
unique identifier for the 
patient 

String 15 Character 

<patient-first-
name> 

First name of the patient String 25 Character 

<patient-last-
name> 

Last name of the patient String 20 Character 

<gender> Indicator for the gender of 
the patient 

String 1 1 = Male 

2 = Female 

3 = Unknown 

<birth-date> Birth date of the patient String 10 MM/DD/YYYY 

<provider-npi> Provider’s NPI String 10 Number 
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XML Element Description Data 
Type 

Field 
Size Valid Values 

<provider-npi-
two> 

Provider’s NPI String 10 Number 

<provider-npi-
three> 

Provider’s NPI String 10 Number 

<clinic-identifer> Identifier associated with the 
clinic 

OR 

-1 to update to NULL 

The identifier must already 
exist in the database before 
it can be used in the XML 
file 

ACO GPROs: The identifier 
may be a participating TIN, a 
CMS Certification Number 

(CCN), or a user entered 
identifier 

PQRS GPROs: The TIN or 
user entered identifier 

String 9 Number 

<caremedcon-
rank> 

Patient’s rank within the 
CARE-1 measure 

This element is only used if 
the patient has been 
selected for the CARE-1 
sample 

String 3 1 – 616 

<carefalls-rank> Patient’s rank within the 
CARE-2 measure 

This element is only used if 
the patient has been 
selected for the CARE-2 
sample 

String 3 1 – 616 
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XML Element Description Data 
Type 

Field 
Size Valid Values 

<cad-rank> Patient’s rank within the 
CAD module 

This element is only used if 
the patient has been 
selected for the CAD sample 

String 3 1 – 616 

<dm-rank> Patient’s rank within the DM 
module 

This element is only used if 
the patient has been 
selected for the DM sample 

String 3 1 – 616 

<hf-rank> Patient’s rank within the HF 
module 

This element is only used if 
the patient has been 
selected for the HF sample 

String 3 1 – 616 

<htn-rank> Patient’s rank within the 
HTN module 

This element is only used if 
the patient has been 
selected for the HTN sample 

String 3 1 – 616 

<ivd-rank> Patient’s rank within the IVD 
module 

This element is only used if 
the patient has been 
selected for the IVD sample 

String 3 1 – 616 

<pcmammogram-
rank> 

Patient’s rank within the 
PREV-5 measure 

This element is only used if 
the patient has been 
selected for the PREV-5 
sample 

String 3 1 – 616 
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XML Element Description Data 
Type 

Field 
Size Valid Values 

<pccolorectal-
rank> 

Patient’s rank within the 
PREV-6 measure 

This element is only used if 
the patient has been 
selected for the PREV-6 
sample 

String 3 1 – 616 

<pcflushot-rank> Patient’s rank within the 
PREV-7 measure 

This element is only used if 
the patient has been 
selected for the PREV-7 
sample 

String 3 1 – 616 

<pcpneumoshot-
rank> 

Patient’s rank within the 
PREV-8 measure 

This element is only used if 
the patient has been 
selected for the PREV-8 
sample 

String 3 1 – 616 

<pcbmiscreen-
rank> 

Patient’s rank within the 
PREV-9 measure 

This element is only used if 
the patient has been 
selected for the PREV-9 
sample 

String 3 1 – 616 

<pctobaccouse-
rank> 

Patient’s rank within the 
PREV-10 measure 

This element is only used if 
the patient has been 
selected for the PREV-10 
sample 

String 3 1 – 616 
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XML Element Description Data 
Type 

Field 
Size Valid Values 

<pcbloodpressure-
rank> 

Patient’s rank within the 
PREV-11 measure 

This element is only used if 
the patient has been 
selected for the PREV-11 
sample 

String 3 1 – 616 

<pcdepression-
rank> 

Patient’s rank within the 
PREV-12 measure 

This element is only used if 
the patient has been 
selected for the PREV-12 
sample 

String 3 1 – 616 

</web-interface> Closing tag for group data N/A N/A N/A 

</export> Closing tag for header N/A N/A N/A 

4.5. Clinics XML 
The Clinics XML file is used to export the list of clinics for a group. The information in the file 
cannot be updated by uploading a file, but clinics may be added or updated using the Group 
Practice Reporting Option Web Interface. 

The audit data is provided to allow tracking of when the file was exported. 

The database will be pre-populated with one or more clinics clinic during the initial load. The 
address for the clinic will not be pre-populated, but will be included if the XML file is exported 
after the clinic has been updated on the Web Interface. 

The table below shows the Clinics XML elements and associated data. 

XML 
Element Description String Field 

Size Valid Values 

N/A XML Declaration String 38 <?xml version=”1.0” 
encoding=”UTF-8”?> 
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XML 
Element Description String Field 

Size Valid Values 

<export> Header String 180 <export version=”3.0” type=”WEB-
INTERFACE-CLINIC” 
xmlns:xsi=”http://www.w3.org/2001/
XMLSchema-instance” 
xmlns:noNamespaceSchemaLocati
on=”WEB-INTERFACE-CLINIC.xsd” 
xmlns=”gov/cms/pqrs/clinic/v1”> 

<file-audit-
data> 

Opening element for file 
audit data 

N/A N/A N/A 

<file-
number> 

Identifier for the file String 20 Number 

<create-
date> 

Date the file was created String 10 MM/DD/YYYY 

<create-
time> 

Time the file was 
created 

Time 5 HH:MM (Military format with colon) 

<create-
by> 

IACS ID and “-WebUI” String 50 Character 

<version> Version of the file being 
exported 

String 20 Character 

</file-
audit-
data> 

Closing element for file 
audit data 

N/A N/A N/A 

<export-
period-
from-
date> 

Start of the Submission 
Period for which data is 
being exported 

String 10 MM/DD/YYYY 

<export-
period-to-
date> 

End of the Submission 
Period for which data is 
being exported 

String 10 MM/DD/YYYY 

<web-
interface> 

Opening element for 
group data 

N/A N/A N/A 
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XML 
Element Description String Field 

Size Valid Values 

<group-
tin> 

ACO GPRO: Primary 
Taxpayer Identification 
Number 

PQRS GPRO: Taxpayer 
Identification Number 

String 9 Number 

<clinic> Opening element clinic 
data, repeats for each 
clinic 

N/A N/A N/A 

<clinic-
identifier> 

ACO GPRO: 
Participating Taxpayer 
Identification Number, 
CMS Certification 
Number, or user 
provided number 

PQRS GPRO: Taxpayer 
Identification Number or 
user provided number 

May be used in the 
Patients XML to 
associate a clinic to a 
patient 

String 9 Number 

<clinic-
name> 

Name of the clinic String 100 Character 

<clinic-
address1> 

First line of the clinic 
address 

String 50 Character 

<clinic-
address2> 

Second line of the clinic 
address 

String 50 Character 

<clinic-
city> 

City for the clinic 
address 

String 50 Character 

<clinic-
state> 

State for the clinic 
address 

String 2 Two digit state codes 

<clinic-
zipcode> 

Zip code for the clinic 
address 

String 10 Five digit (11111) or nine digit 
(11111-1111) zip code 
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XML 
Element Description String Field 

Size Valid Values 

<clinic-is-
original> 

Indicator if the clinic was 
pre-populated during the 
initial data load or added 
during the submission 
period using the Web 
Interface 

String 1 1 = User added, not original 

2 = Pre-populated, original 

</clinic> Closing tag for the Clinic 
data, repeats for each 
clinic 

N/A N/A N/A 

</web-
interface> 

Closing tag for group 
data 

N/A N/A N/A 

</export> Closing tag for header N/A N/A N/A 

4.6. Providers XML 
The Provider XML file is used to export the list of providers for the group. The information in the 
file cannot be updated by uploading a file, but providers may be added or updated using the 
Web Interface. 

The audit data is provided to allow tracking of when the file was exported. 

The database will be pre-populated with providers during the initial load. The pre-populated data 
includes the provider’s first and last name, and the Employer Identification Number, which is 
defaulted to the Primary Taxpayer Identification Number for ACO GPROs and to the Taxpayer 
Identification Number for PQRS GPROs. The pre-populated providers will have the flag set to 
indicate they are original providers. Providers added using the Web Interface will have the flag 
set to indicate they are not original providers. 

The Provider Credentials will not be pre-populated, but will be included if the XML file is 
exported after the provider has been updated on the Web Interface. 

The table below shows the Providers XML elements and associated data. 

XML 
Element Description Data 

Type 
Field 
Size Valid Values 

N/A XML Declaration String 38 <?xml version=”1.0” encoding=”UTF-
8”?> 
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XML 
Element Description Data 

Type 
Field 
Size Valid Values 

<export> Header String 180 <export version=”3.0” type=”WEB-
INTERFACE-PROVIDER” 
xmlns:xsi=”http://www.w3.org/2001/XML
Schema-instance” 
xmlns:noNamespaceSchemaLocation=”
WEB-INTERFACE-PROVIDER.xsd” 
xmlns=”gov/cms/pqrs/provider/v1”> 

<file-audit-
data> 

Opening element for file 
audit data 

N/A N/A N/A 

<file-
number> 

Identifier for the file String 20 Number 

<create-
date> 

Date the file was created String 10 MM/DD/YYYY 

<create-
time> 

Time the file was created Time 5 HH:MM (Military format with colon) 

<create-by> IACS ID and “-WebUI” String 50 Character 

<version> Version of the file being 
exported 

String 20 Character 

</file-audit-
data> 

Closing element for file audit 
data 

N/A N/A N/A 

<export-
period-
from-date> 

Start of the Submission 
Period for which data is 
being exported 

String 10 MM/DD/YYYY 

<export-
period-to-
date> 

End of the Submission 
Period for which data is 
being exported 

String 10 MM/DD/YYYY 

<web-
interface> 

Opening element for group 
data 

N/A N/A N/A 
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XML 
Element Description Data 

Type 
Field 
Size Valid Values 

<group-tin> ACO GPRO: Primary 
Taxpayer Identification 
Number 

PQRS GPRO: Taxpayer 
Identification Number 

String 9 Number 

<provider> Opening element for the 
Provider data 

N/A N/A N/A 

<provider-
npi> 

Provider’s NPI String 10 Number 

<provider-
first-name> 

First name of a provider String 30 Character 

<provider-
last-name> 

Last name of a provider String 30 Character 

<provider-
ein> 

Employer Identification 
Number for a provider 

String 15 Character 

<provider-
credentials> 

Credentials for a provider String 100 Character 

<provider-
is-original> 

Indicator if the provider was 
pre-populated during the 
initial data load or added 
during the submission period 
using the Web Interface 

String 1 1 = User added, not original 

2 = Pre-populated, original 

</provider> Closing tag for the Provider 
data 

N/A N/A N/A 

</web-
interface> 

Closing tag for group data N/A N/A N/A 

</export> Closing tag for header N/A N/A N/A 
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5. XML to Excel Processing 
The Patient, Patient Discharge, Patient Ranking, Clinic and Provider XML files exported for the 
Web Interface may be imported into an Excel file. The Excel file may also be used to create the 
Patients XML and Patient Discharge XML files in the format required to upload into the Web 
Interface. 

5.1. Microsoft Excel 2013 
The following content explains the steps necessary to complete XML to Excel processing with 
Microsoft Excel 2013. In this section, you will learn how to: 

• Add the Developer Tab to Excel 

• Create an Excel Workbook for Patient XML 

• Create an Excel Workbook for the Patient Discharge XML 

• Import the XML File 

• Export the Modified Data 

5.1.1. Add the Developer Tab to Excel 
If the Developer Tab is not shown on the Excel Ribbon it can be added. The following figure 
shows the Excel 2013 ribbon with the Developer Tab displayed. 

 

Steps to display the Developer Tab: 

1. Click the File tab. 

2. Click Options. 

3. Click Customize Ribbon on the Excel Options window. 

4. Select the Developer checkbox under the Main Tabs list if not already checked. 

5. Click OK to apply the setting. 
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The following figure shows the Excel 2013 File Tab with the Options at the bottom of the list. 

 

The following figure shows the Excel 2013 Options screen with the Customize Ribbon and the 
Developer checkbox highlighted. 
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5.1.2. Create an Excel Workbook for Patient XML 
Once the Developer tab is available, the Patient XSD Mapping can be added to a new 2013 
Excel Workbook. The XSD file for the Patient Discharge mapping is the WEB-INTERFACE-
PATIENT.xsd file. 

To add the XSD Mapping: 

1. Select the File tab. 

2. Select New. 

3. Select Blank workbook. 

4. Select the Developer tab. 

5. Select Source in the Developer tab. The XML Source is added to the workbook. 

6. Select the XML Maps… button. 

7. Select the Add… button on the XML Maps screen. 

8. Select the WEB-INTERFACE-PATIENT.xsd file in the Select XML Source window. 

9. Select OK in the XML Maps window. 

10. Select the ns1:patient line on the XML Source with the left mouse button. 

11. Hold the left mouse button down and drag the ns1:patient line to the A1 cell in the 
workbook, then release the mouse button. 

12. Close the XML Source by selecting the Source option in the Developer tab, or selecting 
the “X” in the upper right corner of the XML Source. 
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The following figure shows the File tab with New Blank Excel 2013 workbook selection 
highlighted. 

 

The following figure shows the Source option highlighted with the associated hint displayed. 
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The figure below shows the blank Excel 2013 workbook with the XML Source. 

 

The following figure shows the XML Maps window before adding the Patient XSD to the maps. 

 



XML to Excel Processing 

GPRO-ACO XML Specification v2.0 109 PQRS PY2013 12/20/2013 

The figure below shows the Select XML Source window. 

 

The following figure shows the XML Maps window after adding the Patient XSD. 
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The following figure shows the Excel 2013 workbook after adding the XML Source. 
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The following figure shows the mapping after selecting the ns1:patient line in the XML Source. 
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The following figure shows the Excel 2013 workbook after dragging and dropping the Patient 
XML Mapping to the A1 cell in the workbook. 

 

The following figure shows the Excel 2013 workbook after closing the XML Source. 
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5.1.3. Create an Excel Workbook for Patient Discharge XML 
Once the Developer tab is available, the Patient Discharge XSD Mapping can be added to a 
new 2013 Excel Workbook. The XSD file for the Patient Discharge mapping is the WEB-
INTERFACE-DISCHARGE.xsd file. The remaining steps to create the Patient Discharge 
mapping are the same as for the Patient mapping. 

To add the XSD Mapping: 

1. Select the File tab. 

2. Select New. 

3. Select Blank workbook. 

4. Select the Developer tab. 

5. Select Source in the Developer tab. The XML Source is added to the workbook. 

6. Select the XML Maps… button. 

7. Select the Add… button on the XML Maps screen. 

8. Select the WEB-INTERFACE-DISCHARGE.xsd file in the Select XML Source window. 

9. Select OK in the XML Maps window. 

10. Select the ns1:patient line on the XML Source with the left mouse button. 

11. Hold the left mouse button down and drag the ns1:patient line to the A1 cell in the 
workbook, then release the mouse button. 

12. Close the XML Source by selecting the Source option in the Developer tab, or selecting 
the “X” in the upper right corner of the XML Source. 

5.1.4. Import the XML File 
Once the XSD mapping has been created, a Patients XML file or a Patient Discharge XML file 
exported from the Web Interface can be imported into the mapped workbook. 

To import the file in Excel 2013: 

1. Open the Excel workbook mapped for the type of XML file (Patient or Patient Discharge) 
to be imported. 

2. Click Developer. 

3. Click Import. 

4. Select the appropriate XML file for the mapped workbook in the file selection window. 

5. Click Import. 
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The following figure shows the Excel 2013 ribbon with Developer tab and the Import option 
identified. 

 

5.1.5. Export the Modified Data 
After editing the imported data, the modified data can be exported into the XML format. The file 
will require modification after exporting from Excel and before uploading into the Web Interface. 
See Editing the Exported XML File for the required modifications. 

To export the file in Excel 2013: 

1. Click Developer. 

2. Click Export. 

3. Set Save as type: to XML file (*.xml). 

4. Click Export. 
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The following figure shows the Excel 2013 workbook with the Export XML screen displayed. 

 

5.2. Microsoft Excel 2010 
The following content explains the steps necessary to complete XML to Excel processing with 
Microsoft Excel 2010. In this section, you will learn how to: 

• Add the Developer Tab to Excel 
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• Create an Excel Workbook for Patient XML 

• Create an Excel Workbook for the Patient Discharge XML 

• Import the XML File 

• Export the Modified Data 

5.2.1. Add the Developer Tab to Excel 
If the Developer Tab is not shown on the Excel Ribbon it can be added. The following figure 
shows the Excel 2010 ribbon with the Developer Tab displayed. 

 

Steps to display the Developer Tab: 

1. Click the File tab. 

2. Click Options. 

3. Click Customize Ribbon on the Excel Options window. 

4. Select the Developer checkbox under the Main Tabs list if not already checked. 

5. Click OK to apply the setting. 
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The following figure shows the Excel 2010 File Tab with the Options selection highlighted. 

 

The following figure shows the Excel 2010 Options screen with the Customize Ribbon and the 
Developer checkbox highlighted. 
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5.2.2. Create an Excel Workbook for Patient XML 
Once the Developer tab is available, the Patient XSD Mapping can be added to a new 2010 
Excel Workbook. The XSD file for the Patient Discharge mapping is the WEB-INTERFACE-
PATIENT.xsd file. 

To add the XSD Mapping: 

1. Select the File tab. 

2. Select New. 

3. Select Blank workbook. 

4. Select the Developer tab. 

5. Select Source in the Developer tab. The XML Source is added to the workbook. 

6. Select the XML Maps… button. 

7. Select the Add… button on the XML Maps screen. 
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8. Select the WEB-INTERFACE-PATIENT.xsd file in the Select XML Source window. 

9. Select OK in the XML Maps window. 

10. Select the ns1:patient line on the XML Source with the left mouse button. 

11. Hold the left mouse button down and drag the ns1:patient line to the A1 cell in the 
workbook, then release the mouse button. 

12. Close the XML Source by selecting the Source option in the Developer tab, or selecting 
the “X” in the upper right corner of the XML Source. 

The following figure shows the File tab with New Blank Excel 2010 workbook selection 
highlighted. 
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The following figure shows the Source option highlighted with the associated hint displayed. 

 

The following figure shows the blank Excel 2010 workbook with the XML Source. 
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The following figure shows the XML Maps window before adding the Patient XSD to the maps. 

 

The following figure shows the Select XML Source window. 

 

The following figure shows the XML Maps window after adding the Patient XSD. 
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The following figure shows the Excel 2010 workbook after adding the XML Source. 
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The following figure shows the mapping after selecting the ns1:patient line in the XML Source. 
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The following figure shows the Excel 2010 workbook after dragging and dropping the Patient 
XML Mapping to the workbook. 

 

The following figure shows the Excel 2010 workbook after closing the XML Source. 
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5.2.3. Create an Excel Workbook for Patient Discharge XML 
Once the Developer tab is available, the Patient Discharge XSD Mapping can be added to a 
new 2010 Excel Workbook. The XSD file for the Patient Discharge mapping is the WEB-
INTERFACE-DISCHARGE.xsd file. The remaining steps to create the Patient Discharge 
mapping are the same as for the Patient mapping. 

To add the XSD Mapping: 

1. Select the File tab. 

2. Select New. 

3. Select Blank workbook. 

4. Select the Developer tab. 

5. Select Source in the Developer tab. The XML Source is added to the workbook. 

6. Select the XML Maps… button. 

7. Select the Add… button on the XML Maps screen. 

8. Select the WEB-INTERFACE-DISCHARGE.xsd file in the Select XML Source window. 

9. Select OK in the XML Maps window. 

10. Select the ns1:patient line on the XML Source with the left mouse button. 

11. Hold the left mouse button down and drag the ns1:patient line to the A1 cell in the 
workbook, then release the mouse button. 

12. Close the XML Source by selecting the Source option in the Developer tab, or selecting 
the “X” in the upper right corner of the XML Source. 

5.2.4. Import the XML File 
Once the XSD mapping has been created, a Patients XML file or a Patient Discharge XML file 
exported from the Web Interface can be imported into the mapped workbook. 

To import the file in Excel 2010: 

1. Open the Excel workbook mapped for the type of XML file (Patient or Patient Discharge) 
to be imported. 

2. Click Developer. 

3. Click Import. 

4. Select the appropriate XML file for the mapped workbook in the file selection window. 

5. Click Import. 
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The following figure shows the Excel 2010 ribbon with Developer tab and the Import option 
identified 

 

5.2.5. Export the Modified Data 
After editing the imported data, the modified data can be exported into the XML format. The file 
will require modification after exporting from Excel and before uploading into the Web Interface. 
See Editing the Exported XML File for the required modifications. 

To export the file in Excel 2010: 

1. Click Developer. 

2. Click Export. 

3. Set Save as type: to XML file (*.xml). 

4. Click Export. 
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The following figure shows the Excel 2010 workbook with the Export XML screen displayed. 

 

5.3. Microsoft Excel 2007 
The following content explains the steps necessary to complete XML to Excel processing with 
Microsoft Excel 2007. In this section, you will learn how to: 

• Add the Developer Tab to Excel 

• Create an Excel Workbook for Patient XML 

• Create an Excel Workbook for the Patient Discharge XML 
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• Import the XML File 

• Export the Modified Data 

5.3.1. Add the Developer Tab to Excel 
If the Developer Tab is not shown in Excel, it can be added. The following figure shows the 
Excel 2007 ribbon with the Developer Tab displayed. 

 

Steps to display the Developer Tab: 

1. Click the Microsoft Office Button. 

2. Click Excel Options. 

3. Click Popular. 

4. Select the Show Developer tab in the Ribbon check box. 

5. Click OK to apply the setting. 



XML to Excel Processing 

GPRO-ACO XML Specification v2.0 129 PQRS PY2013 12/20/2013 

 

The following figure shows the Excel 2007 Options screen with the Show developer tab in the 
Ribbon option. 
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5.3.2. Create an Excel Workbook for Patient XML 
Once the Developer tab is available, the Patient XSD Mapping can be added to a new 2007 
Excel Workbook. The XSD file for the Patient Discharge mapping is the WEB-INTERFACE-
PATIENT.xsd file. 

To add the XSD Mapping: 

1. Click the Microsoft Office Button. 

2. Select New. 

3. Select Blank workbook. 

4. Select Create. 

5. Select the Developer tab. 

6. Select Source in the Developer tab. The XML Source is added to the workbook. 

7. Select the XML Maps… button. 

8. Select the Add… button on the XML Maps screen. 
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9. Select the WEB-INTERFACE-PATIENT.xsd file in the Select XML Source window. 

10. Select OK in the XML Maps window. 

11. Select the ns1:patient line on the XML Source with the left mouse button. 

12. Hold the left mouse button down and drag the ns1:patient line to the A1 cell in the 
workbook, then release the mouse button. 

13. Close the XML Source by selecting the Source option in the Developer tab, or selecting 
the “X” in the upper right corner of the XML Source. 

The following figure shows the New Workbook screen with Blank Workbook selection 
highlighted. 
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The following figure shows the Source option highlighted with the associated hint displayed. 

 

The following figure shows the blank Excel 2007 workbook with the XML Source. 
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The following figure shows the XML Maps window before adding the Patient XSD to the maps. 

 

The following figure shows the Select XML Source window. 

 

The following figure shows the XML Maps window after adding the Patient XSD. 
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The following figure shows the Excel 2007 workbook after adding the XML Source. 

 

The following figure shows the mapping after selecting the ns1:patient line in the XML Source. 
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The following figure shows the Excel 2007 workbook after dragging and dropping the Patient 
XML Mapping to the workbook. 

 

The following figure shows the Excel 2007 workbook after closing the XML Source. 
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5.3.3. Create an Excel Workbook for Patient Discharge XML 
Once the Developer tab is available, the Patient Discharge XSD Mapping can be added to a 
new 2007 Excel Workbook. The XSD file for the Patient Discharge mapping is the WEB-
INTERFACE-PATIENT.xsd file. 

To add the XSD Mapping: 

1. Click the Microsoft Office Button. 

2. Select New. 

3. Select Blank workbook. 

4. Select the Developer tab. 

5. Select Source in the Developer tab. The XML Source is added to the workbook. 

6. Select the XML Maps… button. 

7. Select the Add… button on the XML Maps screen. 

8. Select the WEB-INTERFACE-DISCHARGE.xsd file in the Select XML Source window. 

9. Select OK in the XML Maps window. 

10. Select the ns1:patient line on the XML Source with the left mouse button. 

11. Hold the left mouse button down and drag the ns1:patient line to the A1 cell in the 
workbook, then release the mouse button. 

12. Close the XML Source by selecting the Source option in the Developer tab, or selecting 
the “X” in the upper right corner of the XML Source. 

5.3.4. Import the XML File 
Once the XSD mapping has been created, a Patients XML file or a Patient Discharge XML file 
exported from the Web Interface can be imported into the mapped workbook. 

To import the file in Excel 2007: 

1. Open the Excel workbook mapped for the type of XML file (Patient or Patient Discharge) 
to be imported. 

2. Click Developer. 

3. Click Import. 

4. Select the appropriate XML file for the mapped workbook in the file selection window. 

5. Click Import. 
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The following figure shows the Excel 2007 ribbon with Developer tab and the Import option 
identified. 

 

5.3.5. Export the Modified Data 
After editing the imported data, the modified data can be exported into the XML format. The file 
will require modification after exporting from Excel and before uploading into the Web Interface. 
See Editing the Exported XML File for the required modifications. 

To export the file in Excel 2007: 

1. Click Developer. 

2. Click Export. 

3. Set Save as type: to XML file (*.xml). 

4. Click Export. 
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The following figure shows the Excel 2007 workbook with the Export XML screen displayed. 

 

5.4. Editing the Exported XML File 
Excel adds a target name space to the exported XML tags. These tags must be removed before 
uploading the file into the Web Interface. 

The mapping for the Patients XML file described in the Creating an Excel Workbook for Patient 
XML sections excludes the header information to prevent duplicate data in the XML files 
imported into Excel. The header needs to be added prior to uploading the file into the Web 
Interface. 

For more information on creating Excel Workbooks for Patient XML, see the following sections: 

Create a 2013 Excel Workbook for Patient XML  

Create a 2010 Excel Workbook for Patient XML  

Create a 2007 Excel Workbook for Patient XML  
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5.4.1. Remove the Name Space from the XML Tags 
The directions below provide the information to remove the name space using Notepad++. 
Notepad++ is a free source code editor available at notepad-plus-plus.org. 

Files must be saved using encoding UTF-8 without Byte Order Mark (BOM). If any other editor 
is used, care should be exercised when saving the file to ensure that BOM characters or non 
UTF-8 characters are not added to the file. 

To remove the name space added by Excel: 

1. Open the file with Notepad++ or any other editor that has the capability to save with 
encoding UTF-8 without BOM. 

2. Click Search. 

3. Click Replace… from the Search toolbar option. 

The following figure shows a file in Notepad++ with the Replace option highlighted. 

 

4. The Replace screen is displayed. 

5. Enter “ns1:” in the Find what: field. 

6. Leave the Replace with: field blank. 
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7. Click Replace All. 

The following figure shows the Replace screen in Notepad++ used to remove the name space. 

 

5.4.2. Add the Header, Audit Data, and Group Identification Data to the XML 
File 

5.4.2.1. Add the Header, Audit Data, and Group Identification Data to the XML File 

The Header and Group Identification Data are required in the file. The Audit Data is optional to 
provide user information about the file. The lines below should be added to the beginning of the 
file. The header must be an exact match to the header provided below. Replace the 
“MM/DD/YYYY”, “HH:MM”, “XXXXX”, and “000000000” in the lines below appropriate data in 
the file. 

The ACO GPRO Primary Taxpayer Identification Number in the file must match the ACO GPRO 
Primary Taxpayer Identification Number associated to the IACS ID of the user uploading the 
data. 

The PQRS GPRO Taxpayer Identification Number in the file must match the PQRS GPRO 
Taxpayer Identification Number associated to the IACS ID of the user uploading the data. 

5.4.2.2. Patient XML File Header 

The following three lines are added when the Patient XML file is created by Excel. They must be 
removed or the file will be rejected as an invalid file. 

<?xml version=”1.0” encoding=”UTF-8” standalone=”yes”?> 

<submission xmlns:ns1=”gov/cms/pqrs/patient/v1”> 

<web-interface> 

After removing those lines, insert the following header at the top of the file. Note that the XML 
Declaration must be on a separate line. In addition, the data for the <submission> element 
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should be on one line without line returns in the tag. The submission tag is wrapped to fit the 
page in the examples below. 

File Header to replace removed lines in Patient XML file: 

<?xml version=”1.0” encoding=”UTF-8”?> 

<submission version=”3.0” type=”WEB-INTERFACE-PATIENT” 
xmlns:xsi=”http://www.w3.org/2001/XMLSchema-instance” 
xmlns:noNamespaceSchemaLocation=”WEB-INTERFACE-PATIENT.xsd” 
xmlns=”gov/cms/pqrs/patient/v1”> 

<file-audit-data> 

<file-number>1</file-number> 

<create-date>MM/DD/YYYY</create-date> 

<create-time>HH:MM</create-time> 

<create-by>XXXXX</create-by> 

<version>1.0</version> 

</file-audit-data> 

<submission-period-from-date>01/01/2013</submission-period-from-date> 

<submission-period-to-date>12/31/2013</submission-period-to-date> 

<web-interface> 

<group-tin>000000000</group-tin> 

5.4.2.3. Patient Discharge XML File Header 

The following three lines are added when the Patient Discharge XML file is created by Excel. 
They must be removed or the file will be rejected as an invalid file. 

<?xml version=”1.0” encoding=”UTF-8” standalone=”yes”?> 

<submission xmlns:ns1=”gov/cms/pqrs/discharge/v1”> 

<web-interface> 

After removing those lines, insert the following header at the top of the file. Note that the XML 
Declaration must be on a separate line. In addition, the data for the <submission> element 
should be on one line without line returns in the tag. The submission tag is wrapped to fit the 
page in the examples below. 

File Header to replace removed lines in Patient Discharge XML file: 
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<?xml version=”1.0” encoding=”UTF-8”?> 

<submission version=”3.0” type=”WEB-INTERFACE-DISCHARGE” 
xmlns:xsi=”http://www.w3.org/2001/XMLSchema-instance” 
xmlns:noNamespaceSchemaLocation=”WEB-INTERFACE-Discharge.xsd” 
xmlns=”gov/cms/pqrs/discharge/v1”> 

<file-audit-data> 

<file-number>1</file-number> 

<create-date>MM/DD/YYYY</create-date> 

<create-time>HH:MM</create-time> 

<create-by>XXXXX</create-by> 

<version>1.0</version> 

</file-audit-data> 

<submission-period-from-date>01/01/2013</submission-period-from-date> 

<submission-period-to-date>12/31/2013</submission-period-to-date> 

<web-interface> 

<group-tin>000000000</group-tin> 

5.4.3. Save the Modified File with UTF-8 Encoding 
After modifying the file to remove the Namespace and replace the header, the file must be 
saved with encoding UTF-8 without BOM. Files that are not saved with encoding UTF-8 without 
BOM will fail the XML format validation. The encoding UTF-8 without BOM is set in the 
Preferences in Notepad++. 

To set preferences to save the file with UTF-8 Encoding in Notepad++: 

1. Click Settings. 

2. Click Preferences…. 

3. Click the New Document/Default Directory tab on the Preferences window. 

4. Select UTF-8 without BOM in the Encoding section, if not already selected. 

5. Check the Apply to opened ANSI files in the Encoding section, if not already selected. 

6. Select Close. 

The following figure shows the Settings options in Notepad++. 
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The following figure shows the Preferences screen with the New Document/Default Directory 
tab selected. 
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Appendix A – XML Elements for Patients XML File 
The indicator that the XML tag is required, or that data is required in the tag when the tag is 
used, only applies to the XML file format. Data may or may not be needed in order to complete 
the required reporting on the quality measures for the patient. Information on the data required 
to complete reporting on a patient may be found in the disease module, CARE measure, or 
PREV measure sections of this document as well as in the referenced Supporting Documents 
for each module or patient care measure. 

When creating the XML file, the file must be created with UTF-8 encoding without Byte Order 
Mark (BOM). 

XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

XML Declaration <?xml version=”1.0” 
encoding=”UTF-8”?> 

String 38 Yes Yes 

<submission> <submission version=”3.0” 
type=”WEB-INTERFACE-
PATIENT” 
xmlns:xsi=”http://www.w3.org/2001
/XMLSchema-instance” 
xmlns:noNamespaceSchemaLocat
ion=”WEB-INTERFACE-
PATIENT.xsd” 
xmlns=”gov/cms/pqrs/patient/v1”> 

String 180 Yes Yes 

<file-audit-data> Opening element for file audit 
data, tag does not contain data 

N/A N/A Conditional – 
required if any 
of the sub 
elements of the 
tag are used 
(i.e. the tags 
between the 
opening <file-
audit-data> tag 
and the closing 
</file-audit-
data> tag) 

N/A 

<file-number> 1 – 999 

File number is not validated, it may 
be used by the GPRO for their 
tracking of XML files 

String 3 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<create-date> Date in MM/DD/YYYY format 

Date is not validated, it may be 
used by the GPRO for their 
tracking of XML files 

String 10 No No 

<create-time> Time in HH:MM or HHMM 

Create Time is not validated, it 
may be used by the GPRO for 
their tracking of XML files 

Time 5 No No 

<create-by> When exported will contain the 
IACS ID of the user and “-WebUI” 

For upload, up to 50 characters 
may be provided 

String 50 No No 

<version> 1 – 99999 

Version is not validated, it may be 
used by the GPRO for their 
tracking of XML files 

String 5 No No 

</file-audit-data> Closing element for file audit data, 
tag does not contain data 

N/A N/A Conditional – 
required if the 
opening <file-
audit-data> is 
used 

N/A 

<submission-
period-from-date> 

Date in MM/DD/YYYY format 

Date is not validated, it may be 
used by the GPRO for their 
tracking of XML files 

String 10 No No 

<submission-
period-to-date> 

Date in MM/DD/YYYY format 

Date is not validated, it may be 
used by the GPRO for their 
tracking of XML files 

String 10 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<web-interface> Opening element for the group’s 
data, tag does not contain data 

<web-interface> 

N/A N/A Yes N/A 

<group-tin> ACO GPRO: Primary Taxpayer 
Identification Number 

PQRS GPRO: Taxpayer 
Identification Number 

String 9 Yes Yes 

<patient> Opening element for an individual 
patient’s data, may be repeated 
with a matching closing element 
for each patient, opening tag does 
not contain data 

N/A N/A Yes N/A 

<medicare-id> The Medicare ID is the unique 
identifier for the patient and 
associated data contained 
between the opening <patient> 
and closing </patient> tags 

The Medicare ID should only be 
used once for each patient in the 
Patients XML file 

String 15 Yes Yes 

<patient-first-
name> 

String containing the first name of 
the patient 

Name is included in the export to 
aid in locating the patient, but the 
name cannot be modified using an 
XML upload 

String 25 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<patient-last-
name> 

String containing the last name of 
the patient 

Name is included in the export to 
aid in locating the patient, but the 
name cannot be modified using an 
XML upload 

String 20 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 

<gender> 1 = Male 

2 = Female 

3 = Unknown 

Gender is included in the export to 
aid in locating the patient, but the 
gender cannot be modified using 
an XML upload 

String 1 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 

<birth-date> MM/DD/YYYY 

Date of birth is included in the 
export to aid in locating the 
patient, but the date of birth cannot 
be modified using an XML upload 

String 10 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<medical-record-
number> 

Character String 25 No No 

<other-id> Character String 20 No No 

<provider-npi> Numeric 

OR 

-1 to update to NULL 

The NPI must exist already in the 
database before it can be used in 
the XML file 

String 10 No No 

<provider-npi-two> Numeric 

OR 

-1 to update to NULL 

The NPI must exist already in the 
database before it can be used in 
the XML file 

String 10 No No 

<provider-npi-
three> 

Numeric 

OR 

-1 to update to NULL 

The NPI must exist already in the 
database before it can be used in 
the XML file 

String 10 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<clinic-identifier> Identifier associated with the clinic 

OR 

-1 to update to NULL 

The identifier must already exist in 
the database before it can be used 
in the XML file 

ACO GPROs: The identifier may 
be a participating TIN, a CMS 
Certification Number (CCN), or a 
user entered identifier 

PQRS GPROs: The TIN or user 
entered identifier 

String 9 No No 

<general-
comments> 

Text 

OR 

-1 to update to NULL 

String 250 No No 

<medical-record-
found> 

2 = Yes 

3 = Medical Record Not Found 

9 = Not Qualified for Sample 

-1 to update to NULL 

String 3 No No 

<medical-not-
qualified-reason> 

10 = In Hospice 

11 = Moved out of Country 

12 = Deceased 

16 = HMO Enrollment 

-1 to update to NULL 

String 10 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<medical-not-
qualified-date> 

Date in MM/DD/YYYY format 

Valid date between 01/01/2013 
and 12/31/2013 

OR 

-1 to update to NULL 

String 3 No No 

<caremedcon-
rank> 

1 to 616 

Rank is provided in an exported 
file for information only, rank 
cannot be modified in an XML 
upload or in the Web Interface 

String 3 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 

<caremedcon-
confirmed> 

CARE-1 

2 = Yes 

15 = No – Other CMS Approved 
Reason 

-1 = Update to NULL 

String 3 No No 



Appendix A – XML Elements for Patients XML File 

GPRO-ACO XML Specification v2.0 151 PQRS PY2013 12/20/2013 

XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<carefalls-rank> 1 to 616 

Rank is provided in an exported 
file for information only, rank 
cannot be modified in an XML 
upload or in the Web Interface 

String 3 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 

<carefalls-
confirmed> 

CARE-2 

2 = Yes 

15 = No – Other CMS Approved 
Reason 

-1 = Update to NULL 

String 3 No No 

<falls-screening> 

CARE-2 

1 = No 

2 = Yes 

4 = No – Medical Reasons 

-1 = Update to NULL 

String 3 No No 

<care-comments> 

CARE-1 and 
CARE-2 

Text 

OR 

-1 = Update to NULL 

String 250 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<cad-rank> 1 to 616 

Rank is provided in an exported 
file for information only, rank 
cannot be modified in an XML 
upload or in the Web Interface 

String 3 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 

<cad-confirmed> 2 = Yes 

8 = Not Confirmed 

15 = No – Other CMS Approved 
Reason 

-1 = Update to NULL 

String 3 No No 

<cad-ldlc-control> 

CAD-2 

1 = No 

2 = Yes 

4 = No – Medical Reasons 

5 = No – Patient Reasons 

6 = No – System Reasons 

-1 = Update to NULL 

String 3 No No 

<cad-diabetes> 

CAD-7 

1 = No 

2 = Yes 

-1 = Update to NULL 

String 3 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<cad-lvsd> 

CAD-7 

1 = No 

2 = Yes 

-1 = Update to NULL 

String 3 No No 

<cad-acearb> 

CAD-7 

1 = No 

2 = Yes 

4 = No – Medical Reasons 

5 = No – Patient Reasons 

6 = No – System Reasons 

-1 = Update to NULL 

String 3 No No 

<cad-comments> Text String 250 No No 

<dm-rank> 1 to 616 

Rank is provided in an exported 
file for information only, rank 
cannot be modified in an XML 
upload or in the Web Interface 

String 3 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<dm-confirmed> 2 = Yes 

8 = Not Confirmed 

13 = Not Confirmed – Medical 
Reasons 

15 = No – Other CMS Approved 
Reason 

-1 = Update to NULL 

String 3 No No 

<dm-hba1c-test> 

DM-2 and DM-15 

1 = No 

2 = Yes 

-1 = Update to NULL 

String 3 No No 

<dm-hba1c-date> 

DM-2 and DM-15 

MM/DD/YYYY 

(Must be a valid date in 2013) 

OR 

-1 to update to NULL 

String 10 No No 

<dm-hba1c-value> 

DM-2 and DM-15 

0-25 with one or two optional 
decimal places (XX.XX) 

OR 

-1 to update to NULL 

String 5 No No 

<dm-recent-bp> 

DM-13 

1 = No 

2 = Yes 

-1 = Update to NULL 

String 3 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<dm-bp-date> 

DM-13 

MM/DD/YYYY 

(Must be a valid date in 2013) 

OR 

-1 to update to NULL 

String 10 No No 

<dm-bp-systolic> 

DM-13 

0 – 350 

OR 

-1 to update to NULL 

String 3 No No 

<dm-bp-diastolic> 

DM-13 

0 – 200 

OR 

-1 to update to NULL 

String 3 No No 

<dm-ldlc-test> 

DM-14 

1 = No 

2 = Yes 

-1 = Update to NULL 

String 3 No No 

<dm-ldlc-date> 

DM-14 

MM/DD/YYYY 

(Must be a valid date in 2013) 

OR 

-1 to update to NULL 

String 10 No No 

<dm-ldlc-value> 

DM-14 

0 – 500 

OR 

-1 to update to NULL 

String 3 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<dm-ivd> 

DM-16 

1 = No 

2 = Yes 

-1 = Update to NULL 

String 3 No No 

<dm-aspirin> 

DM-16 

1 = No 

2 = Yes 

4 = No – Medical Reasons 

-1 = Update to NULL 

String 3 No No 

<dm-tobacco> 

DM-17 

1 = No (Screened and a tobacco 
user) 

2 = Yes (Screened and a tobacco 
non-user) 

14 = Not Screened 

-1 = Update to NULL 

String 3 No No 

<dm-comments> Text String 250 No No 

<hf-rank> 1 to 616 

Rank is provided in an exported 
file for information only, rank 
cannot be modified in an XML 
upload or in the Web Interface 

String 3 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<hf-confirmed> 2 = Yes 

8 = Not Confirmed 

15 = No – Other CMS Approved 
Reason 

-1 = Update to NULL 

String 3 No No 

<hf-lvsd> 

HF-6 

1 = No 

2 = Yes 

-1 = Update to NULL 

String 3 No No 

<hf-beta-blocker> 

HF-6 

1 = No 

2 = Yes 

4 = No – Medical Reasons 

5 = No – Patient Reasons 

6 = No – System Reasons 

-1 = Update to NULL 

String 3 No No 

<hf-comments> Text String 250 No No 

<htn-rank> 1 to 616 

Rank is provided in an exported 
file for information only, rank 
cannot be modified in an XML 
upload or in the Web Interface 

String 3 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<htn-confirmed> 2 = Yes 

8 = Not Confirmed 

15 = No – Other CMS Approved 
Reason 

-1 = Update to NULL 

String 3 No No 

<htn-recent-bp> 

HTN-2 

1 = No 

2 = Yes 

4 = No – Medical Reasons 

-1 = Update to NULL 

String 3 No No 

<htn-bp-date> 

HTN-2 

MM/DD/YYYY 

(Must be a valid date in 2013) 

OR 

-1 to update to NULL 

String 10 No No 

<htn-bp-systolic> 

HTN-2 

0 to 350 

OR 

-1 to update to NULL 

String 3 No No 

<htn-bp-diastolic> 

HTN-2 

0 to 200 

OR 

-1 to update to NULL 

String 3 No No 

<htn-comments> Text String 250 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<ivd-rank> 1 to 616 

Rank is provided in an exported 
file for information only, rank 
cannot be modified in an XML 
upload or in the Web Interface 

String 3 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 

<ivd-confirmed> 2 = Yes 

8 = Not Confirmed 

15 = No – Other CMS Approved 
Reason 

-1 = Update to NULL 

String 3 No No 

<ivd-lipid-
performed> 

IVD-1 

1 = No 

2 = Yes 

-1 = Update to NULL 

String 3 No No 

<ivd-lipid-date> 

IVD-1 

MM/DD/YYYY 

(Must be a valid date in 2013) 

OR 

-1 to update to NULL 

String 10 No No 

<ivd-ldlc-value> 

IVD-1 

0 – 500 

OR 

-1 to update to NULL 

String 3 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<ivd-
antithrombotic> 

IVD-2 

1 = No 

2 = Yes 

-1 = Update to NULL 

String 3 No No 

<ivd-comments> Text String 250 No No 

<pcmammogram-
rank> 

1 to 616 

Rank is provided in an exported 
file for information only, rank 
cannot be modified in an XML 
upload or in the Web Interface 

String 3 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 

<pcmammogram-
confirmed> 

PREV-5 

2 = Yes 

15 = No – Other CMS Approved 
Reason 

String 3 No No 

<pcmammogram> 

PREV-5 

1 = No 

2 = Yes 

4 = No – Medical Reasons 

-1 = Update to NULL 

String 3 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<pccolorectal-
rank> 

1 to 616 

Rank is provided in an exported 
file for information only, rank 
cannot be modified in an XML 
upload or in the Web Interface 

String 3 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 

<pccolorectal-
confirmed> 

PREV-6 

2 = Yes 

15 = No – Other CMS Approved 
Reason 

String 3 No No 

<pccolorectal> 

PREV-6 

1 = No 

2 = Yes 

4 = No – Medical Reasons 

-1 = Update to NULL 

String 3 No No 

<pcflushot-rank> 1 to 616 

Rank is provided in an exported 
file for information only, rank 
cannot be modified in an XML 
upload or in the Web Interface 

String 3 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<pcflushot-
confirmed> 

PREV-7 

2 = Yes 

15 = No – Other CMS Approved 
Reason 

String 3 No No 

<pcflushot> 

PREV-7 

1 = No 

2 = Yes 

4 = No – Medical Reasons 

5 = No – Patient Reasons 

6 = No – System Reasons 

-1 = Update to NULL 

String 3 No No 

<pcpneumoshot-
rank> 

1 to 616 

Rank is provided in an exported 
file for information only, rank 
cannot be modified in an XML 
upload or in the Web Interface 

String 3 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 

<pcpneumoshot-
confirmed> 

PREV-8 

2 = Yes 

15 = No – Other CMS Approved 
Reason 

String 3 No No 

<pcpneumoshot> 

PREV-8 

1 = No 

2 = Yes 

4 = No – Medical Reasons 

-1 = Update to NULL 

String 3 No No 



Appendix A – XML Elements for Patients XML File 

GPRO-ACO XML Specification v2.0 163 PQRS PY2013 12/20/2013 

XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<pcbmiscreen-
rank> 

1 to 616 

Rank is provided in an exported 
file for information only, rank 
cannot be modified in an XML 
upload or in the Web Interface 

String 3 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 

<pcbmiscreen-
confirmed> 

PREV-9 

2 = Yes 

15 = No – Other CMS Approved 
Reason 

String 3 No No 

<pcbmicalculated> 

PREV-9 

1 = No 

2 = Yes 

4 = No – Medical Reasons 

5 = No – Patient Reasons 

-1 = Update to NULL 

String 3 No No 

<pcbminormal> 

PREV-9 

1 = No 

2 = Yes 

-1 = Update to NULL 

String 3 No No 

<pcbmiplan> 

PREV-9 

1 = No 

2 = Yes 

-1 = Update to NULL 

String 3 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<pctobaccouse-
rank> 

1 to 616 

Rank is provided in an exported 
file for information only, rank 
cannot be modified in an XML 
upload or in the Web Interface 

String 3 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 

<pctobaccouse-
confirmed> 

PREV-10 

2 = Yes 

15 = No – Other CMS Approved 
Reason 

String 3 No No 

<pctobaccoscreen
> 

PREV-10 

1 = Screened and a non-tobacco 
user 

2 = Screened and a tobacco user 

4 = No – Medical Reasons 

14 = Not Screened 

-1 = Update to NULL 

String 3 No No 

<pctobaccocounse
l> 

PREV-10 

1 = No 

2 = Yes 

-1 = Update to NULL 

String 3 No No 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<pcbloodpressure-
rank> 

1 to 616 

Rank is provided in an exported 
file for information only, rank 
cannot be modified in an XML 
upload or in the Web Interface 

String 3 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 

<pcbloodpressure-
confirmed> 

PREV-11 

2 = Yes 

15 = No – Other CMS Approved 
Reason 

String 3 No No 

<pcbloodpressure
> 
PREV-11 

1 = No 

2 = Yes 

4 = No – Medical Reasons 

5 = No – Patient Reasons 

-1 = Update to NULL 

String 3 No No 

<pcdepression-
rank> 

1 to 616 

Rank is provided in an exported 
file for information only, rank 
cannot be modified in an XML 
upload or in the Web Interface 

String 3 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used 
in 
upload, 
the data 
will not 
be 
updated 
in the 
databas
e 
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XML Element / 
Measure Valid Values Data 

Type 
Field 
Size Tag Required 

Data 
Require
d in Tag 

<pcdepression-
confirmed> 

PREV-12 

2 = Yes 

15 = No – Other CMS Approved 
Reason 

String 3 No No 

<pcdepression> 

PREV-12 

1 = No 

2 = Yes 

4 = No – Medical Reasons 

5 = No – Patient Reasons 

-1 = Update to NULL 

String 3 No No 

<pcdepression-
positive> 

PREV-12 

1 = No 

2 = Yes 

-1 = Update to NULL 

String 3 No No 

<pcdepression-
plan> 

PREV-12 

1 = No 

2 = Yes 

-1 = Update to NULL 

String 3 No No 

<prev-comments> Text String 250 No No 

</patient> Closing element for an individual 
patient’s data, may be repeated 
with a matching opening element 
for each patient, closing tag does 
not contain data 

N/A N/A Yes N/A 

</web-interface> Closing element for the group’s 
data, tag does not contain data 

N/A N/A Yes N/A 

</submission> Closing tag for header N/A N/A Yes N/A 
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Appendix B – XML Elements for Patient Discharge XML File 
The indicator that the XML tag is required, or that data is required in the tag when the tag is 
used, only applies to the XML file format. Data may or may not be needed in order to complete 
the required reporting on the quality measures for the patient. Information on the data required 
to complete reporting on a patient may be found in the individual disease module, CARE 
measure, or PREV measure sections of this document as well as in the referenced Supporting 
Documents for each module or patient care measure. 

When creating the XML file, the file must be created with UTF-8 encoding without Byte Order 
Mark (BOM). 

XML Element Valid Values/Sample XML Tag Data 
Type 

Field 
Size Tag Required 

Data 
Require
d in Tag 

XML 
Declaration 

<?xml version=”1.0” encoding=”UTF-
8”?> String 38 Yes Yes 

<submission> <submission version=”3.0” type=”WEB-
INTERFACE-DISCHARGE” 
xmlns:xsi=”http://www.w3.org/2001/XM
LSchema-instance” 
xmlns:noNamespaceSchemaLocation=
”WEB-INTERFACE-DISCHARGE.xsd” 
xmlns=”gov/cms/pqrs/discharge/v1”> 

String 180 Yes Yes 

<file-audit-
data> 

Opening element for file audit data, tag 
does not contain data 

N/A N/A Conditional – 
required if any 
of the sub 
elements of the 
tag are used 

N/A 

<file-number> 1 – 999 

File number is not validated, it may be 
used by the GPRO for their tracking of 
XML files 

String 3 No No 

<create-date> Date in MM/DD/YYYY format 

Date is not validated, it may be used by 
the GPRO for their tracking of XML files 

String 10 No No 
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XML Element Valid Values/Sample XML Tag Data 
Type 

Field 
Size Tag Required 

Data 
Require
d in Tag 

<create-time> Time in HH:MM or HHMM 

Create Time is not validated, it may be 
used by the GPRO for their tracking of 
XML files 

Time 5 No No 

<create-by> When exported will contain the IACS ID 
of the user and “-WebUI” 

For upload, up to 50 characters may be 
provided 

String 50 No No 

<version> 1 – 99999 

Version is not validated, it may be used 
by the GPRO for their tracking of XML 
files 

String 5 No No 

</file-audit-
data> 

Closing element for file audit data, tag 
does not contain data 

N/A N/A Conditional – 
required if the 
opening <file-
audit-data> is 
used 

N/A 

<submission-
period-from-
date> 

Date in MM/DD/YYYY format 

Date is not validated, it may be used by 
the GPRO for their tracking of XML files 

String 10 No No 

<submission-
period-to-
date> 

Date in MM/DD/YYYY format 

Date is not validated, it may be used by 
the GPRO for their tracking of XML files 

String 10 No No 

<web-
interface> 

Opening element for the group’s data, 
tag does not contain data 

<web-interface> 

N/A N/A Yes N/A 
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XML Element Valid Values/Sample XML Tag Data 
Type 

Field 
Size Tag Required 

Data 
Require
d in Tag 

<group-tin> ACO GPRO: Primary Taxpayer 
Identification Number 

PQRS GPRO: Taxpayer Identification 
Number 

String 9 Yes Yes 

<patient> Opening element for an individual 
patient’s discharge data, may be 
repeated with a matching closing 
element for each discharge, opening 
tag does not contain data 

N/A N/A Yes N/A 

<medicare-id> The Medicare ID is the unique identifier 
for the patient and associated data 
contained between the opening 
<patient> and closing </patient> tags 

The Medicare ID should be used once 
for each patient’s discharge data in the 
Patient Discharge XML file 

String 15 Yes Yes 

<medical-
record-found> 

2 = Yes 

3 = Medical Record Not Found 

9 = Not Qualified for Sample 

-1 = Update to NULL 

String 3 No No 

<medical-not-
qualified-
reason> 

10 = In Hospice 

11 = Moved out of Country 

12 = Deceased 

16 = HMO Enrollment 

-1 = Update to NULL 

String 3 No No 
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XML Element Valid Values/Sample XML Tag Data 
Type 

Field 
Size Tag Required 

Data 
Require
d in Tag 

<medical-not-
qualified-
date> 

MM/DD/YYYY 

(Must be a valid date in 2013) 

OR 

-1 to update to NULL 

String 10 No No 

<caremedcon
-rank> 

1 to 616 

Rank is provided in an exported file for 
information only, rank cannot be 
modified in an XML upload or in the 
Web Interface 

String 3 For Export 
Only 

If used in 
upload, the tag 
will be ignored 

For 
Export 
Only 

If used in 
upload, 
the data 
will not 
be 
updated 
in the 
database 

<caremedcon
-confirmed> 

CARE-1 

2 = Yes 

15 = No – Other CMS Approved 
Reason 

String 3 No No 

<care-
comments> 

Text String 250 No No 

<discharge-
date> 

CARE-1 

MM/DD/YYYY 

Must be a valid date in 2013, and must 
be one of the pre-populated dates for 
the patient 

See note in Section 0 on date range 
validation 

String 10 Yes Yes 

<discharge-
confirmation> 

CARE-1 

1 = No 

2 = Yes 

-1 = Update to NULL 

String 3 No No 
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XML Element Valid Values/Sample XML Tag Data 
Type 

Field 
Size Tag Required 

Data 
Require
d in Tag 

<office-visit> 

CARE-1 

1 = No 

2 = Yes 

-1 = Update to NULL 

String 3 No No 

<medication-
reconciliation
> 

CARE-1 

1 = No 

2 = Yes 

-1 = Update to NULL 

String 3 No No 

</patient> Closing element for an individual 
patient’s discharge data, may be 
repeated with a matching opening 
element for each discharge, closing tag 
does not contain data 

N/A N/A Yes N/A 

</web-
interface> 

Closing element for the group’s data, 
tag does not contain data > 

N/A N/A Yes N/A 

</submission
> 

Closing tag for header N/A N/A Yes N/A 
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Acronyms 
This section describes the acronyms used in this document. 

Acronym Literal Translation 

ACE-I/ARB Angiotensin-Converting Enzyme Inhibitor or Angiotensin Receptor 
Blocker 

ACO Accountable Care Organization 

BMI Body Mass Index 

CAD Coronary Artery Disease 

CARE Care Coordination/Patient Safety 

CCN CMS Certification Number 

CMS Centers for Medicare & Medicaid Services 

DM Diabetes Mellitus 

GPRO Group Practice Reporting Option 

HF Heart Failure 

HMO Health Maintenance Organization 

HTN Hypertension 

IVD Ischemic Vascular Disease 

LDL-C Low-Density-Lipoprotein Cholesterol 

LVEF Left Ventricular Ejection Fraction 

LVSD Left Ventricular Systolic Dysfunction 

NPI National Provider Identifier 
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Acronym Literal Translation 

mg/dL Milligrams per Deciliter 

mmHg Millimeters of Mercury 

PQRS Physician Quality Reporting System 

PREV Preventive Care 

TIN Taxpayer Identification Number 

XML Extensible Markup Language 
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Referenced Documents 
The documents listed in the table below were used in whole or in part to develop the content 
within this document. Documents are available on the CMS website on the PQRS GPRO Web 
Interface page   

Document Name Document 
Number 

Issuance 
Date 

2013 GPRO CAD Supporting Documents v4.2  N/A July 2013 

2013 GPRO CARE Supporting Documents v4.2  N/A July 2013 

2013 GPRO DM Supporting Documents v4.2  N/A July 2013 

2013 GPRO HF Supporting Documents v4.2  N/A July 2013 

2013 GPRO HTN  Supporting Documents v4.2  N/A July 2013 

2013 GPRO IVD Supporting Documents v4.2  N/A July 2013 

2013 GPRO PREV Supporting Documents v4.2  N/A July 2013 
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Revision History 

Version Date Organization/Point of Contact Description of Changes 

1.0 08/28/13 DECC Initial Version 

1.1 10/19/13 DECC Updated to support changes to 
Patient XSD 

1.2 11/25/13 DECC Corrected errors in Section 5.4.3 

1.3 12/10/13 DECC Updated based on feedback 
received 

2.0 12/20/13 DECC Updated for I-ORR  
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